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About Dataradio

Dataradio is the leading designer and manufacturer of trusted wireless products and systems for critical
infrastructure applications. Our products have been found at the heart of mobile and SCADA data networks around
the world for over 20 years. Dataradio products include mobile data products and systems, telemetry devices,
integrated wireless modems for fixed point-to-point and point to multi-point applications and OEM solutions. Our
product line is one of the broadest and most trusted in the industry.

Product Warranty

The manufacturer's warranty statement for this product is available in our manuals or by contacting Dataradio COR
Ltd. 299 Johnson Avenue, Suite 110, Waseca, MN 56093-0833. Phone (507) 833-8819.

www.dataradio.com
Dataradio provides product brochures, case studies software downloads and product information on our website.

Every effort is taken to provide accurate, timely product information in this installation manual. Product updates may result in
differences between the information provided herein and the product shipped. The information in this document is subject to
change without notice.
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Section 1

PRODUCT OVERVIEW

1.1 Scope Of Manual

This document provides information required for the operation and preventive maintenance of the Dataradio COR
Ltd. Integra-H Spread Spectrum wireless modem. This manual is intended for system designers, professional
installers, and maintenance technicians.

1.2 General Description

The Integra-H is a license-free high-speed protocol transparent wireless modem. It is designed specifically to fit the
needs of Supervisory Control And Data Acquisition (SCADA), telemetry, and control applications. Integra-H
provides the communication links to data equipment for installations where wired communication is impractical.

Integra-H will work with most makes and models of Remote Terminal Units (RTU) and programmable logic
controllers (PLC) and their protocols. Configuration settings allow tailoring for a variety of application
requirements.

Integra-H supports:
1. Point-to-Point configuration.
2. Point-to-Multipoint configurations.

Settings and connections for these configurations are given later in this manual.

1.2.1 Characteristics

Integra-H has the following operational characteristics:

» Fixed network speed of 25600 b/s

* One COM port for connection to DTE. Speeds of 1200 - 19200 baud

» One Setup port for configuration and diagnostics. Output speed fixed to 9600 baud, 8 bit, no parity, 1
stop bit

* Built-in 0.1 — 1 watt transceiver, operating in the 902-928 MHz unlicensed frequency hopping band

» Fully transparent operation with error-free data delivery (no “dribble bits™)

» Allows transmission of “break” characters

» DOX (Data Operated Transmit) or RTS mode

» Two 8-bit analog inputs (0 - 10V)

* Low power consumption mode: “sleep” mode

* 12 VDC, negative ground” device

1.2.2 International 900 MHz Band Use

Some countries use selected portions of the 902-928 license-free band (see Table 1.1).
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Table 1.1 International Band Use

Country MHz Sub-Band
Australia 915-928 9-16
Canada 902-928 1-16 (all)
Columbia 902-924 1-13

El Salvador* 904-928 3-16
Guatemala* 904-928 3-16
Honduras* 904-928 3-16
New Zealand 921-929 13-16
Nicaragua* 904-928 3-16
Panama* 904-928 3-16
Puerto Rico 902-928 1-16 (all)
United States 902-928 1-16 (all)
Venezuela 902-928 1-16 (all)

*Use may be restricted and may require permit from government and/or military agencies

1.2.3 Accessories and Options

Table 1.2 lists various accessory items available for the Integra-H Wireless Modem.

Table 1.2 Accessories

Accessory DRL Part Number
Field Programming Software kit (software and interface cable) 250-4099-001
SMA Male - BNC Female Adapter Cable 023-3410-098
Power cable 697-4008-001
Integra Interface/Programming Cable 697-4008-408
DIN-rail Mounting Kit 250-5800-408

For information on accessories and options, contact your sales representative. In the United States, phone 1-800-
992-7774. For International Sales, phone 507-833-88109.

1.2.4 Configuration

Operating characteristics of the Integra-H are configured by means of the Integra-H Field Programming Software
(H-FPS). The Field Programming Software permits both local and remote diagnostics. This program is Win/95 or
later based (16 Megabytes of memory required). See Section 3 for detailed Integra-H programming information.
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1.3 Factory Technical Service

The Technical Service Department provides customer assistance for technical problems and serves as an interface
with factory repair facilities. They can be reached in the following ways:

Dataradio COR Ltd.
299 Johnson Avenue, Suite 110
Waseca, MN 56093-0833

Phone: 1-800-992-7774 or 1-507-833-8819
Fax: 1-507-833-6758

E-mail address: support@dataradio.com
Technical Service hours are: Monday to Friday 7:30 AM to 4:30 PM, Central Time

1.4 Product Warranty
The warranty statement for the Integra-H is available in the Appendix.

1.5 Replacement Parts

This product is normally not field-serviceable, except by the replacement of complete units. Specialized equipment
and training is required to repair logic boards and radio modules.

1.6 Factory Repair

Dataradio products are designed for long life and failure-free operation. If a problem arises, factory service is
available. Contact Technical Service for information before returning equipment. A Technical Service
representative may suggest a solution eliminating the need to return equipment.

A Return Material Authorization (RMA) is required when returning equipment to Dataradio for repair. Contact the
Technical Service Department at 800-992-7774, extension 6707 to request an RMA number. Be prepared to give
the equipment model and serial number, your account number (if known), and billing and shipping addresses.
Information regarding equipment return is also available on our website at www.dataradio.com

Include the RMA number, a complete description of the problem, and the name and phone number of a contact
person with the returned units. This information is important. The technician may have questions that need to be
answered to identify the problem and repair the equipment. The RMA number helps locate your equipment in the
repair lab if there is a need to contact Dataradio concerning the equipment. Units sent in for repair will be returned
to the customer re-tuned to the current Dataradio Test and Tune Procedure and will conform to all specifications
noted in this section

Customers are responsible for shipping charges (to Dataradio) for returned units in warranty. Units in warranty are
repaired free of charge unless there is evidence of abuse or damage beyond the terms of the warranty. Dataradio
covers return shipping costs for equipment repaired while under warranty.

Units out of warranty are subject to repair service charges. Customers are responsible for shipping charges (to and
from Dataradio) on units out of warranty. Return shipping instructions are the responsibility of the customer.
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1.7 Physical Description

The Integra-H wireless modem consists of a logic PCB (which includes modem circuitry) and a radio module.
Each logic PCB and radio module is constructed in the factory to optimize performance as a wireless modem. The
two boards are installed in an extruded aluminum case.

The Integra-H wireless modem “hops” from channel to channel several times per second using a “hop” pattern
applied to the Master and Remotes in a network. A distinct hopping pattern is provided for each of the available
System IDs. This distinct pattern minimizes the chance of interference with other spread spectrum networks. In the
United States (and certain other countries), no license is necessary to install and operate this type of spread
spectrum system.

DTE connection is made via a front panel connector. Power is applied through a rear panel 4-pin connector which
includes two analog connections usable as inputs.

The unit is not hermetically sealed and should be mounted in a suitable enclosure when dust and/or a corrosive
atmosphere are anticipated. Physically, there are no external switches or adjustments. All operating parameters are
set using the Integra-H FPS.

1.8 Diagnostics

The Integra-H wireless modem has sophisticated built-in diagnostics that may be transmitted automatically without
interfering with normal network operation. In addition, commands to generate test transmissions (etc.) may be
issued either locally or remotely. Diagnostic information takes one of two forms:

Online Diagnostics: Each unit, at the beginning of every data transmission, automatically sends Information.
Online Diagnostics are available via the Setup Port using Integra-H FPS. The Online Diagnostics are also output as
comma delimited ASCII character sets. Refer to Section 2.6.1 for more information.

Offline Diagnostics: Information is sent by a specific unit in response to an inquiry made locally or from another
station utilizing the Integra H-FPS. The user application is normally shut down during Offline Diagnostics.

1.9 Firmware Upgrades

The Integra-H firmware resides in flash EPROM and is designed to allow field upgrades.

Upgrades are performed with the Integra-H FPS using a PC connected to the Integra-H Setup port. Upgrades do not
require opening the unit but may require interaction with DRL's Technical Service. Refer to Section 3.4 for further
information on firmware programming.

1.10 Installation
The following sections describe the installation requirements for the Integra-H Wireless Modem.
1.10.1 Professional Installation Required

The Integra-H uses low power radio frequency transmitters. The concentrated energy from an
antenna may pose a health hazard. People should not be in front of the antenna when the

<<< . >>> transmitter is operating.
A

RF Exposure

001-4099-101 1-4



The installer of this equipment must ensure the antenna is located or pointed such that it does not emit an RF field
in excess of Health Canada limits for the general population; consult Safety Code 6 (available from Health
Canada).

The Integra-H complies with Part 15 of the FCC rules and must be professionally installed. Operation must
conform to the following two conditions:

» This device may not cause harmful interference.
» This device must accept any interference received including interference that may cause undesired
operation of the device.

1.10.2 Antenna Connection

This equipment has been tested and approved with antennas having a maximum gain of 10 dB. Antennas with a
higher gain are strictly prohibited (regulations of Industry Canada). The required antenna impedance is 50 ohms.
To reduce potential radio interference, the antenna type and its gain should be chosen to ensure the effective
isotropic radiated power (EIRP) is not more than required for successful communication.

FCC/IC Rule: The output power is not to exceed 1.0 watt (30 dBm) and the EIRP not to exceed 6 dBi gain
(36dBm). A sample calculation is provided below.

Sample Calculation: Yagi Antenna: 10 dBi, which exceeds 6 dBi gain by 4 dB
(see Figure 1-1) Cable Loss: 1 dB
Integra-H output initially set to 30 dBm (1 watt).

(initial output level) dBm - (excess antenna gain) dB + (cable loss) dB = (new power setting) dBm
Therefore, the sample calculation becomes: 30dBm — 4 dB + 1dB = 27 dBm

The Integra-H output must be reduced by 3 dB to 27 dBm (refer to Section 3.3.1.3 for setting radio power).

10 dBi Gain Yagi
ERIP = 36 dBm

‘MUHH

SN —
Integra
o U \®27 dBm H

—m O O

Figure 1.1 Sample Equation Graphic

1.10.3 Acceptable Antennas

The antennas listed in Table 1.3 were tested and typed for maximum gain. These antennas are FCC approved for
use with the Integra-H. Similar antenna types from other manufacturers are also acceptable.
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Table 1.3 Acceptable Antennas

Type Manufacturer Part Number Gain (dBi)

Yagi Maxrad MYG9159 10

Omni Directional Maxrad MFB9157 7

Unity Gain Maxrad MFB9150 0

Whip Maxrad EXE-902-SM or 0
EXR-902-BN

1.10.4 RF Exposure Compliance Requirements

The Integra-H is intended for use in the SCADA market. The Integra-H must be professionally installed to ensure a
minimum separation distance of more than 37 cm between the radiating structure and any person. An antenna
mounted on a pole or tower is the typical installation and in rare instances, a 1/2 wave whip antenna is used.

The Integra-H uses low power radio frequency transmitters. The concentrated energy from an
antenna may pose a health hazard. People should not be in front of the antenna when the

<< (o >>> transmitter is operating.
A

This device complies with Part 15 of FCC rules:

“Operation is subject to the following two conditions; (1) This device may not cause harmful interference,
and (2) this device must accept any interference received including interference that may cause undesired
operation.”

RF Exposure

1.11 Network Application

The Integra-H wireless modem is suited to a variety of network applications. Its primary design goal satisfies the
needs of SCADA systems using RTUs, PLCs, or other similar equipment in either point-to-point or point-to-
multipoint service.

This section gives an overview of some common configurations. Selection of “Master” or “Remote” as well as data
delivery conditions are done using the Integra-H FPS (see Section 3.3).

1.11.1 RF Path and Communications Range

The reliable communication range of the Integra-H is dependent on terrain, RF (radio frequency) path obstacles,
and antenna system. To assure reliable communications, a competent professional who can determine what
antennae are required and whether or not a repeater is needed should study the RF path between stations.
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1.11.2 Basic Connections
Required connections are shown in Figure 1.2.

% Antenna

13.3VDC/15A
Regulated Power Supply
connects on rear

Integra
O
o & T
Cable Part Number
697-4008-408
Setup PC -]

ﬁ I§TU or PLC

Figure 1.2 Required Basic Connections

While an RTU or PLC is shown in the diagram, Master stations often use a PC running an application designed to
communicate with remote RTUs or PLCs. The Setup PC is used for both configuration and diagnostics. It may be
left connected at all times to gather diagnostics, but is not required for normal operation once the unit has been
configured. Continually monitoring the Setup port with the Integra-H FPS may slow down data processing.

1.11.3 Common Characteristics
The networks described in this section share common characteristics:

» Each Remote unit in the system must have the same system ID as its' Master.
» Transmission of Online Diagnostics may be enabled or disabled at any station or stations without
affecting their ability to communicate with other stations.

1.11.4 Point-to-Point System
A simple point-to-point connection is shown in Figure 1.3.

() oo
DTE e e DTE

— —{*

Figure 1.3 Point-to-Point System

In this system, the user's equipment (DTE) is set up in a Master-Remote configuration.
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1.11.5 Point-to-Multipoint System
Basic point-to-multipoint systems are shown in Figure 1.4:

T O @ Remote

oo & Remote
Master mm O O
T O 9D Remote

ﬂ

Figure 1.4 Point-to-Multipoint System

Using the Integra-H FPS, one Integra-H must be set as a “Master” unit. The remaining units in the network must be
set to “Remote”. All units are set to “Selective” data delivery to prevent Remote stations from hearing each other's
responses (see Section 3.3 for parameter programming details).

1.11.6 Extending a Landline (Tail Circuit)

The Integra-H may be used to extend a landline circuit (giving access to difficult locations, etc.). This type of
connection is called a “tail circuit” and is shown in Figure 1.5. The tail circuit assembly may be used in any of the
network types described in the preceding sections. Note: The phone-line modems should be full duplex units.

Phone Phone Dojm O
DTE Line Line
Modem Modem
)
Dedicated
Line DCE Crossover
Cable

Figure 1.5 Landline (Tail Circuit)
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DE-9M DE-9M

7—+—RIS —— DCD—1
31T—TXD —— RXD — 2
2 1T—RXD ———— TXD — 3
8 —CIS ——— DIR— 4
S 1T—GND —— GND—5

6
1——DCD —+—— RTS — 7
4 —DTR ——+—— CTS —1 8

9

Figure 1.6 DCE Crossover Cable for RTS-CTS mode

Some point-to-point FDX landline modems or line drivers may require the use of DOX mode and an alternate pin-
out for DTR, DCD, CTS and RTS as shown in Figure 1.7.

37— TXD —— RXD — 2
2 17— RXD ————— TXD —— 3
54— GND —— GND—F 5

Figure 1.7 DCE Crossover Cable for DOX mode

Remote
System ID X SystemIDY [
/ w=m O S
Remote
Mastf[ Rem(:tt"e Mast.?[ O O
==l==ier e oo & ? oo O
Serial RS-232 +H>
Serial RS-232
Store and Forward Remote
Device
ocoO O

Figure 1.8 Point-to-Multipoint Using a Store and Forward Device
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System ID Xn (odd)
Hop Sequence A

o

System ID Y

HOPW

~H+ W

Master (B)

Master (A) Remote (A)

oo O O oo O

mm O O

Data Line Harness
Serial RS-232 Null Modem Cable

Figure 1.9 Point-to-Multipoint (Repeater)

For the Point-to-Multipoint (Repeater) configuration shown in Figure 1.9, System IDs should be set such that one
is an odd number and one an even number. The odd numbered System ID will offset the channel frequencies by 25
kHz from the even System ID channels, which further reduces the chance of inter-system hop frequency

interference. The two units set up as the repeater should be set to 19,200 baud data rates for optimum data transfer

Remote (B)

oo S O

across the entire network. Refer to Section 3.3.1 for System ID programming.
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Integra-H General Specifications

These specifications are subject to change without notice.

Modem Interface

Interface (COM Port)

EIA RS-232

Data Rate

1200-19200 b/s

Protocol

Transparent, 7 or 8 data bits, 1 or 2 stop bits, even, odd, or no parity

Transmit Control

RTS or DOX (data operated transmit)

General

Frequency 902-928 MHz

IF Channel Steps 50 kHz for systems
IF Channel Bandwidth 30 kHz

Operating Temperature -30°C to + 60°C

Supply Voltage

10 - 16 VDC maximum

Receive Current

220 mA maximum

Transmit Current

650 mA (1 watt into 50 ohms), 1.0A maximum

Sleep Mode Current

25 mA average

Data Format

Asynchronous

Network Rate

25600 b/s

Data Protocol

Transparent to user data

Nominal Dimensions

457 x2.0”"x4.75”" (11.4cm x 5.0 cm x 12.1 cm)

Channels

1024 (512 maximum per system)

Receiver

Intermodulation 75 dB
Spurious Rejection 80 dB
Secondary Image 65 dB

Packet Error Rate (PER)

<1% degradation @ -107 dBm

Transmitter

RF Power Output

0.1 - 1 Watt, software adjustable

Spurious and Harmonics

<-35 dBm (<-25 dBm 2nd harmonics)

Frequency Stability

+1.5 ppm

Output Impedance

50 ohms

Maximum SWR

Stable over 5to 1

Tx Duty Cycle

100% (internally controlled by hopping transitions)
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Modem/Logic

Operation

Switched Simplex

Modulation Type

DRCMSK (Differential Raise-Cosine Minimum Shift Keying)

RTS/CTS Delay (RTS mode)

4 ms

Addressing

8 bit station address, 1 bit station type (Master, Remote)

‘Programming and Diagnostics

Interface (Setup Port)

EIA RS-232

Data Format

Proprietary binary for setup, ASCII for diagnostics

Data Rate

9600 b/s, 8 bit, no parity, 1 stop bit

Analog Inputs

Interface

Two inputs, 0-10 VDC, 8 bits Read via Offline Diagnostics only. Absolute
maximum input voltage < 20 VDC. Inputs are reverse-voltage protected.

‘Display

|4 Bi-color Status LEDs

RUN/PWR, CS/SYN, RX/TX, RD/TD

‘Connectors

RF SMA Female

COM DE-9F

SETUP/DIAG DE-9F

Power/Analog Snap and Lock 4-Pin DC Power Jack

Diagnostics

Online Short ID, Temperature, B+ Voltage, Local RSSI, Remote RSSI, Fwd Power,
Rev Power Integrity (Good/Bad), Rx Quality

Offline Short ID, Temperature, B+ Voltage, Local RSSI, Fwd Power, Relative Rev
Power, Rx Quality, Analog Input Levels
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Section 2

Features and Operation

2.1 Overview

This chapter describes the connections, indicators, and operating characteristics of the Integra-H wireless modem.
This chapter is intended for system application and installation personnel.

2.2 Safety Notice

The Integra-H uses low power radio frequency transmitters. The concentrated energy from an
antenna may pose a health hazard. People should not be in front of the antenna when the transmitter

<<(i)>> is operating.

This device complies with Part 15 of FCC rules:

RF Exposure

“Operation is subject to the following two conditions; (1) This device may not cause harmful interference,
and (2) this device must accept any interference received including interference that may cause undesired
operation.”

2.3 Front Panel
The various front panel elements are described in the following sections.

Figure 2.1 Integra-H Front Panel

2.3.1 Antenna Connector

The antenna connector is a female 50 ohm SMA type. The Integra-H is designed to operate with an antenna having
a maximum gain of 10 dBi. Antennae with higher gain are strictly prohibited (FCC and Industry Canada).
Required antenna impedance is 50 ohms. The installer of this equipment must ensure the antenna does not emit an
RF field in excess of Health Canada limits for the general population (Safety Code 6 available form Health
Canada). See Section 1.10.4 for RF exposure compliance requirements.
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2.3.2 LED Indicators
Integra-H has four dual color LED indicators. Their functions are shown in Table 2.1.

Table 2.1 LED Color Functions

RUN/PWR Green Normal operation
Flash green Sleep mode
Flash red & green Setup mode or loading new application or new bootloader
Red CPU or PROM error*
CS/ISYN Off No RF Rx carrier
Green Receive carrier present
Red Out of Sync (applies to Remote only)
Rx/Tx Off Idle
Green Receiving network data
Red Transmitter is on
TD/TD Off Idle
Green Rx Data outgoing from RS-232 port
Red Tx data incoming from RS-232 port

* Contact technical support.

2.3.3 Connection to DTE

Integra-H is configured as DCE. Most DTE should be connected using a nine-conductor pin-to-pin “straight” cable.
Some RTUs or PLCs may require a special cable to route the signals correctly. See the documentation for your data
equipment for further information.

2.3.4 COM Port

Serial baud rates from 1200 to 19200 are supported. The Integra-H is factory set (default) for 9600 b/s, 8 bits, no
parity, and 1 stop bit.

Table 2.2 COM Port Signals

Pin |Name |Function

1 DCD |Output: Always asserted or asserted when receive RF carrier present (selectable via Integra-H FPS)

2 RXD  |OQutput: Data from Integra-H to DTE

3 TXD Input: Data from DTE to Integra-H

4 DTR Input: Ignored

5 GND |Signal and chassis ground

6 DSR Output: always positive

7 RTS Input: Used as a “begin transmission” signal in RTS mode will “wake up” unit in sleep mode

8 CTS Output: Used for handshaking in RTS mode and used for flow control in DOX mode RTS mode:
RTS to CTS delay in 4 ms DOX mode: CTS always asserted except when data overflow is detected

9 RI Not internally connected, reserved
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2.3.4.1 Connector Pin Out
The DE-9F pin out is shown in Figure 2.2 for reference. Refer to Table 2.2 for pin descriptions.

54321

o o o O O
o o O O
9876
Figure 2.2 COM and Setup Port Connector Pin Location

2.3.4.2 Wire Connection (DOX)
For DTE that lack RTS control, the Integra-H can operate in DOX mode (Data Operated Transmit) with only
Transmit Data, Receive Data, and Ground (*“3-wire interface”).

DE-9M
1
RXD — 2
TXD — 3
4
GND 5
6
7
8
9

Figure 2.3 3-Wire Interface

2.3.5 Setup Port
The Setup port uses a DE-9 female connector configured as DCE. Signals are described in Table 2.3.

Table 2.3 Setup Port Signals

Pin Name Function

1 DCD Tied directly to DTR

2 RXD Data from Integra-H to setup PC

3 TXD Data from setup PC to Integra-H

4 DTR Tied directly to DCD

5 GND Signal and chassis ground

6 DSR Output: always positive (asserted)

7 RTS Tied to CTS. Also monitored to “wake up” unit from sleep mode
8 CTS Tied to RTS

9 RI Not internally connected, reserved

The Setup port uses a proprietary communications protocol designed to work with the Integra-H FPS. It is also
designed to provide ASCII numeric diagnostics information when connected to a PC terminal emulator. See section
2.6.1 for diagnostics format.
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2.4 Rear Panel

Figure 2.4 Integra-H Rear Panel

2.4.1 Heat Sink

The rear panel heat sink is essential for proper operation of the Integra-H transmitter. The unit must be mounted in
a location that permits free air circulation past the heat sink. Cooling will be most efficient if the fins are vertical.

2.4.2 Power

The Integra-H power requires a regulated power source of 12 to 14 VDC nominal (10 - 16 VDC max.) negative
ground with a minimum 1.5 A rating. An internal surface-mount 3A modem fuse (not field-replaceable) and a
crowbar diode protect the main RF power components from reverse polarity.

WARNING: Do not exceed 16VDC.

Application of more than 16 VDC will damage the unit and is not covered by the warranty. If the detected supply
voltage reaches approximately 16.5 VDC, all front panel LEDs will flash yellow and transmissions will be
disabled.

2.4.3 Power / Analog connector
The 4-pin power / analog connector pin out is shown in Figure 2.5.

12-14 VDC (1) (2) Ground

(Red) (Black)
Analog 1 (3) (4) Analog 2
(Green) (White)

Figure 2.5 Power / Analog Connector

Note: The color of the power cable wires are shown in parenthesis. If the analog connections are not used the green
and white wires should be cut back and/or taped to prevent contact. (See Table 1.2 for power cable part number)
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2.4.4 Analog connections

The two analog inputs are scaled between 0 and 10 VDC and have a resolution of eight bits (1 part in 256).
Monitoring inputs, measured in tenths of a volt, are referenced to chassis ground. The absolute maximum input
voltage should not exceed 20 VDC. These inputs are reverse-voltage protected. The Integra-H allows reading the
analog values, locally or remotely, using the Offline Diagnostics function of the Integra-H FPS.

2.5 Operation

The Integra-H is designed for fully transparent operation. This means that all binary serial values are transmitted as
data with minimum time delays and without regard to their binary value. “Break” signals can also be transmitted.
Unlike most transparent wireless modems, the Integra-H eliminates “bit dribble” and allows DOX operation. A
CRC-16 error check is used so that faulty data will not be delivered.

2.5.1 Operating Modes
Integra-H has two operating modes for its COM port: (selectable via the Integra-H FPS)

DOX mode: The RS-232 port is monitored for incoming data. Upon receipt of the first data byte, the unit begins
transmitting. The RTS signal is ignored (Note: RTS may still be used as a wakeup signal for a unit that is
functioning in sleep mode).

RTS mode: The RTS signal is monitored for a low-to-high transition. CTS is raised 4 ms later to accommodate
DTE that requires a CTS transition before it can send data.

CTS is used as a handshaking/flow control signal in both operating modes. If the Integra-H's input buffers fill, CTS
will be dropped as a signal to the DTE to stop sending data.

2.5.2 Data Forwarding Timer

The data forwarding timer can modify the timing between data blocks in a transmission to accommodate some
RTU's special timing requirements. Set to “normal” (15 ms) unless advised otherwise by technical support. Do not
use “fast” (5 ms) timer below 2400 baud.

2.5.3 Sending Break Signals

The Integra-H may be configured to send “break” signals, as required by some SCADA user protocols. A break
signal is generated by holding TXD in the zero state for longer than one character time. Indication of a break signal
is carried in a special data transmission to the Remote station, which in turn generates its own output break signal.

At a port speed of 19200 b/s, the output break signal has a duration of 5 to 10 ms, regardless of the duration of the
input break signal. These times are scaled proportionally for other baud rates. The Integra-H may also be set to
ignore “break” signals in order to prevent spurious transmissions when terminal equipment is powered on and off.

2.5.4 COM Port Baud Rates

The COM port operates at standard baud rates from 1200 to 19200 b/s. Baud rate is set using the Integra-H FPS.
The COM port will support 7 or 8 data bits, 1 or 2 stop bits, and even, odd or no parity. Selection is made via the
Integra-H FPS. These parameters may be set differently on various Integra-H units without affecting their ability to
communicate with each other over the air.

2.5.5 Addressing
Each Integra-H is associated with three identification numbers (see Section 3.3.1 for further information):
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ESN: The Electronic Serial Number is uniquely assigned to each Integra-H at time of manufacture and cannot be
changed. It is identical to the serial number printed on the label of the unit. The Integra-H uses this number for
identification only; it does not form part of the on-air protocol.

System ID: This number can be set from 1 to 65,535 and must be a unique number common to all units in the same
communication network. Setting the System ID to an even number will set the hopping frequency range to 902.200
- 927.750 MHz, for a total of 512 channels separated by 50 kHz. Setting the system ID to an odd number will set
the hopping frequency range to 902.225 - 927.775 MHz (off-set by 25 kHz from the even set).

Short ID: The short ID (maximum value of 254) is used to identify the Integra-H for purposes of diagnostics (both
online and offline) and remote configuration and commands. This value may be changed via the Integra-H FPS. It
is important that all stations within a communicating group have unique Short IDs.

2.5.6 Station Type
The Station Type is a 1-bit value used to identify the station as a Master or Remote. On simplex or repeater
networks, all Remote stations can hear the Master and many Remote stations can hear each other. Certain SCADA

protocols are designed with the assumption that Remote stations cannot hear the responses to polls made by other
Remote stations.

To allow operation with such protocols in simplex networks, the Integra-H has a simple addressing scheme.
Stations may be designated as Master or Remote. This sets a flag in the header identifying the type of the
originating station. For the Integra-H, the Master station periodically transmits synchronization information to the
Remote station at all times.

On the receive side, the Integra-H stations can be set to accept all data, or accept data only if it originates from a
station of the opposite type (selective). The Data Delivery option is set using the Integra-H FPS (see Section 3.3.1).

2.6 Online Diagnostics

Transmitted Online Diagnostics may be enabled or disabled on a per-unit basis without affecting inter-
communication. Enabling this option adds about 2.5 ms delay at 19.200 b/s, 5 ms at 9600 b/s or 10 ms at 4800 b/s
to each transmission, but has no other effect on network operation. Online diagnostics are delivered locally to a
unit’s own Setup Port, regardless of the Online Diagnostics setting, at the start of each data transmission and also at
intervals of 20 seconds. If enabled, diagnostics are sent on the network but only at the start of the first data
transmission. Reception of Online Diagnostics is always enabled and is delivered out the Setup Port in a comma
delimited, ASCII character, format.

Online Diagnostics do not interfere with normal network operation. The following information is gathered:

e Unit's “Short ID”

* Inside case temperature: in degrees C

» Supply voltage (B+): in volts

* Local unit received signal strength: in dBm

* Remote unit received signal strength: in dBm

» Forward power: in watts

» Reverse power indication: Good / Bad

* Receive quality: based on last 15 data blocks received

Refer to Section 3.5.1 & 3.5.2 for further Online Diagnostics information.
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2.6.1 Using an External Program for Online Diagnostics
The Setup Port communicates with the Integra-H FPS using a proprietary protocol. If a terminal or PC running

terminal software is connected to the Setup Port, online diagnostic information will be delivered in comma
delimited ASCII form.

2.6.1.1 Initialization

When powered on, the Integra-H will attempt to establish a link with the Integra-H FPS and select its output mode
as follows:

1. If RTS is not exerted on the Setup Port, Integra-H will immediately switch to ASCII mode.

2. IfRTS s exerted on the Setup Port, Integra-H will send an initialization message to the Integra-H FPS
and wait for a proper response from the Integra-H FPS.

3. If there is no response, Integra-H will switch to ASCII diagnostics mode.

A user-program should initialize the PC serial port with RTS false. This disables the Integra-H FPS mode and only
ASCII diagnostics data will be output from the port.

2.6.2.2 Online Diagnostic String Format

In ASCII output mode, the setup port will output a one line diagnostic string each time the unit receives a
transmission from another unit. No other data will be output. The string consists of a number of comma-delimited
fields terminated by a carriage return. Each field within itself is a constant length, but the fields are not all uniform
in length. For the purpose of this manual, the “local” station is the unit connected to the PC via its Setup Port and
the “remote” station is the unit communicating with the “local” station. Field definitions are shown in Table 2.4.

Table 2.4 Online Diagnostic Field Definitions

Name Length (in bytes) | Description
Short ID 4 1-254
Temperature |3 Signed value
B+ 4 From 6.0 to 18.8 V displayed (10-16 VVDC radio operating limits)
Remote RSSI |4 Signal strength received by the “remote” unit (in dBm) from the “local” unit
Local RSSI 4 Signal strength received by the “local” unit (in dBm)
FWD Power |4 From 0.1 to 1 watt
Rev Power 1 0 =good1 = bad
Rx Quality 3 Number of good data blocks received in the last 15
3 Number of total data blocks detected, maximum 15

For a system having a Master unit (ID #5), connected to the PC via its Setup Port, and communicating with a
Remote unit (ID #3), the Master unit becomes the “local” station and the Remote unit becomes the “remote”
station.
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A typical diagnostic string, 0003,+028,13.1,-093,-088,0.96,0,015,015, would be interpreted as:
Remote station # 3 reports that:

» Its Internal case temperature is +28°C

» Its Supply Voltage is 13.1 VDC

» Itisreceiving a signal of -93 dBm from the Master

» The Master is receiving a signal of -88 dBm from station 003
» Its forward power is 0.96 watts

» ltsreflected power is Good (value of 0)

» 15 of the last 15 data blocks were received correctly

Refer to Section 3.5.2 for further information on Online Diagnostics using the Integra-H FPS.

2.7 Offline Diagnostics

Offline Diagnostics are returned in response to a specific request to a particular station. Requests are issued using
the Integra-H FPS, either locally or remotely from another station. This may cause slight temporary network
disruption. We recommend the user application be offline.

The diagnostic information available is similar to that available from Online Diagnostics with the following
additions:

* Analog 1 input voltage: 0 - 10.0 VDC

* Analog 2 input voltage: 0 - 10.0 VDC

* Reverse power: in relative watts rather than a good / bad flag.

Refer to Section 3.5.3 for further information on Offline Diagnostics using the Integra-H FPS.

2.8 Interpreting Diagnhostic Results

Interpretation of the diagnostic results is similar for both Online and Offline Diagnostics. Differences will be noted
where they exist in the text. For simplicity, we continue to assume that diagnostics are being collected at the Master
station.

2.8.1 ShortID

The Short ID identifies the unit whose diagnostic data is being displayed. Users should make sure that all units in a
communicating group have unique Short IDs. The Short ID number range is 1-254.

2.8.2 Temperature

Internal case temperature of sending unit. This is a 3-digit signed value in degrees C. This value should remain
within the limits of -30°C to +60°C.

2.8.3 B+ Voltage

Current value of the unit’s supply voltage. SWB+ is a 3-digit (4-byte) value in volts, e.g. a value of 13.3 indicates
13.3 VDC. This value should remain within the limits of 10-16 VDC.

2.8.4 Remote RSSI

Displays the strength of the last valid data signal received by a reporting Remote unit. In a polling type network, the
last signal usually originates from the polling Master unit. For the Master itself, the last signal received is that of the
Remote that answered the previous poll. This is a 3-digit value, plus the leading minus sign, expressed in dBm with
a typical accuracy of +/- 3dB. For example, a value of -090 indicates a signal strength of -90 dBm.
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2.8.5 Local RSSI

Displays the strength of the last valid data signal received by the connected Integra-H unit, usually the Master. The
format described in the Remote RSSI section above applies.

2.8.6 Interpreting RSSI Readings

Typical values of RSSI will be in the range of -110 to -60 dBm with higher values (i.e. less negative values)
indicating a stronger signal.

Reliability of data reception depends largely on signal strength. Good design practice calls for a minimum 30 dB
“fade margin”, based on a threshold reception level of -107 dBm (1 uV) at speeds of 9600 b/s.

Some representative performance values for 9600 b/s operation are given below. These values assume that the units
are correctly aligned and installed in a quiet location. Environments with high electrical or RF noise levels will
require an increase in the numbers shown to achieve a given level of reliability.

-100 dBm Approximately 50% reliability. Fading may cause frequent data loss.
-90 dBm Approximately 90% reliability. Fading will cause occasional data loss.
-80 dBm Approximately 99% reliability. Reasonable tolerance to most fading.
-70 dBm Approximately 99.9% reliability with high tolerance to fading.

If RSSI values drop seasonally the most likely cause is tree foliage which can interfere with radio transmissions.

2.8.7 Forward Power

Forward power values are an approximate measure of transmit power. This is a value in watts rounded to the
nearest hundredth. Note that this is an approximate value that should be used for trend monitoring only. It does not
compare in accuracy with values obtained by a standard wattmeter.

2.8.8 Interpreting Forward Power Readings

The values returned are approximate and should not be regarded as an absolute indicator of performance. For this
reason, these values should not be used to indicate that a unit is out of spec or to compare one unit to another.

However, the values returned should be consistent for any given unit. If statistics are kept on a unit per unit basis,
changes in forward or reflected power can be monitored. The following conditions are worthy of investigation.

1. Forward power output (in watts) drops or rises by more than 10% from its established value.
Reflected power remains low. This indicates that the transmitter may need alignment or that a compo-
nent may be in need of replacement.

2. Forward power output drops by more than 10% from its established value or reflected power shows
an increase. This indicates a possible antenna or feedline problem that affects SWR (Standing Wave
Ratio).

2.8.9 Reverse Power

A relative measure of reverse (reflected) power. The value is returned differently for Online and Offline
Diagnostics:

Online: The value returned is O if reverse power is within acceptable limits, 1 if reverse power is too high. The
threshold is set to approximately 1/2 of the forward power value.
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Offline: Value is in watts relative to forward power and is displayed to the nearest hundredth. This value is
intended as an indication of antenna problems and will normally be used for trend monitoring. Ideally it should be
close or below 0.2, but values up to about 50% of Forward Power may be encountered in properly operating
systems.

It is recommended that the user record values following original installation for use as future reference.

2.8.10 Reverse Power and SWR

A reverse power reading above 0.60 is an indication that the antenna, feedline or connectors are damaged, corroded
or improperly tuned. This creates standing waves that are reported as a Standing Wave Ratio (SWR).

Table 2.5 is based on a forward power of 1 watt (it may be scaled for lower power settings) and gives guidelines to
interpreting these figures:

Table 2.5 Reverse Power/SWR Reading Definitions

SWR Rev Pwr Significance

1:1 <0.20 Ideal situation

151 0.35 Normal operation

2:1 0.50 Should be investigated

3:lor 0.60 or greater Defective antenna, feedline, or connectors
greater

Should values returned by the built-in diagnostics seem to indicate a problem, verify using proper radio shop
equipment.

2.8.11 RX Quality Indicator

This is the number of good received data transmissions out of the last 15. The receive quality indicator value
returned by any Remote unit to the Master station is an indication of the reception quality on the outbound path.

If the Master station is monitored, users should note that the receive quality indicator returned is a composite value
which represents the average reception from the last 15 Remotes. Any significant drop in the receive quality
indicator returned by the Master station is likely to indicate a problem with the Master station receiver itself rather
than any one Remote station.

2.9 Low Power Operation
To accommodate users who operate sites with limited available power, the Integra-H offers:

* Reduced transmit power
» Sleep mode.

2.9.1 Reduced Transmit Power

The Integra-H transmitter is type-approved for power levels varying from 0.1 to 1 Watt. The FCC requires effective
isotropic radiated power (EIRP) does not exceed 6 dBW. See Section 1.10.2, ‘Antenna Connection’, for proper
power settings when using an antenna with a directional gain greater than 6 dBi. Use the Integra-H FPS program to
set the appropriate power level (refer to Section 3.3.1.3, ‘Radio Setup Parameters’). Setting transmitter power to a
level sufficient for quality data transmissions but less than maximum will assist the user in power conservation.
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2.9.2 Sleep Mode

In this mode, the unit is always in low power consumption. Only asserting RTS on the COM or the SETUP ports
can wake-up the unit. When the unit is sleeping, it cannot detect the presence of a carrier. The unit will be ready to
receive a carrier and decode after synchronization with the Master. The synchronization time will depend on the
number of sub-bands chosen. The unit will resume sleep mode approximately one second after RTS is lowered.
Sleep mode can be selected from the Integra-H FPS (see Section 3.3.1).

Raising either of the Integra-H’s RTS inputs, by a Remote Terminal Unit (RTU), can awaken a Remote Integra-H
from “sleep”.

DOX mode: The RTS, on either the COM or SETUP port, can be used for wake-up. Data from DTE cannot wake-
up the unit.

RTS mode: The RTS on the SETUP port can be used for wake-up without causing transmission.

2.10 Optimizing Your System

Detailed system engineering is beyond the scope of this manual. However, there are some simple tips that can be
used to optimize performance of a radio based SCADA or telemetry system.

Choose an optimal number of frequency sub-bands: Using all 16 sub-bands will generally reduce system
degradation from short-term interference occurring in the operating band. However, if constant interference is
occurring, disabling sub-bands where interference exists will improve the overall performance of the system. The
diagnostics tools available in the Integra-H FPS, can aid in finding problem areas in the operating band. Refer to
Section 4 on Network Troubleshooting.

Reducing the number of sub-bands will also allow for faster Remote synchronization when coming out of Sleep
Mode or any other time synchronization is interrupted.

Choose the best protocol: Some SCADA devices allow a choice of more than one operating protocol. In some
cases, performance can be improved by selecting a different protocol. Contact Technical Service for assistance.

Check timer settings: Polling protocols wait a period of time for a response after issuing a poll. The Integra-H adds
a short amount of delay to each poll and response (typically in the order of 60 to 100 ms). Timer settings that are
too short may cause erroneous indication of missed polls, in which case the application may retry or continue to
cycle, ignoring the missed station. In this case, the response may collide with the next poll, further increasing
errors. Setting an adequate timer margin will avoid problems and maximize performance.

Use the highest suitable port baud rate: Operating an RTU at 1200 b/s will increase data transmission delays and
reduce system performance.
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Section 3

Integra-H Field Programming Software

3.1 Introduction

The Integra-H Field Programming Software, or Integra-H-FPS, is the programming and diagnostic software for the
Dataradio Integra-H series Data Modem. The Integra-H-FPS will help the user complete the following tasks:

» Edit and program the user programmable settings for the Integra-H Wireless Modem.
» Update Integra-H Wireless Modem Firmware
* Monitor diagnostic data from the Integra-H Wireless Modem.

This manual assumes the user has successfully installed the Field Programming Software on their computer and it
has at least one operational Serial COM Port available. Figure 3.1 shows the initial Integra-H FPS screen at startup.

= IntegraH Programmer

Tool Bar - Can be turned On or Off in the Utilities pulldown menu.

Primary COM Port
Status Bar

Secondary COM Port

Current Parameter Data File

 Jeom srogrammersiintsgrahdefluplosd st
Figure 3.1 Integra-H FPS Screen at startup

3.2 Serial COM Port Settings

Programming the Integra-H parameters is done through the Primary COM Port. The serial cable is connected from
the Setup Port on the Integra-H to the COM Port configured as the Primary port. The Port Settings screen is
accessed through the Utilities menu.
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Figure 3.2 Port Settings Screen

Figure 3.2 shows the Port Settings screen. A useful feature of the Port Settings screen is the Swap Com Ports
function. Selecting the Swap Com Ports button will swap the Secondary COM Port to the Primary and vice versa.
The specific COM Port parameter settings are listed below and are also available in the online Help screens. The
COM Port assignments are displayed in the bottom Status bar as shown in Figure 3.1.

Com Port: Selects the COM Port number (COM 1 - 4) to use for the Primary and Secondary COM ports.

Baud Rate: Selects the communication speed for the Primary and Secondary COM Ports. Available settings are
1200, 2400, 4800, 9600, & 19200.

Data Bits: Selects the number of Data Bits (4 - 8) that will be transmitted or received for the Primary and
Secondary COM Ports.

Parity: Selects whether any Parity Bits (None/Odd/Even) will be transmitted or received for the Primary and
Secondary COM Ports.

Stop Bits: Selects the number of Stop Bits (1 or 2) that will be transmitted or received for the Primary and
Secondary COM Ports.

DTR Enable: Selects whether the DTR (Data Terminal Ready) line of the RS-232 port will be asserted when the
port is open for the Primary and Secondary COM Ports.

Mode: Selects the communications mode for the Primary and Secondary COM Ports.
Sync/Esc with No HS: Send data using the Sync/Esc byte-stuffing protocol with no handshaking.
Buffered with No HS: Send buffered data without any handshaking.

Sync/Esc with RTS/CTS HS: Send data using the Sync/Esc byte-stuffing protocol with RTS/CTS hardware
handshaking.
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Buffered with RTS/CTS HS: Send buffered data with RTS/CTS hardware handshaking.

Sync/Esc with Flow Control HS: Send data using the Sync/Esc byte-stuffing protocol with flow control
handshaking.

Buffered with Flow Control HS: Send buffered data with flow control hardware handshaking.

3.3 Integra-H Wireless Modem Parameter Programming

The parameter setup screen is accessed from the Edit menu pull-down or by selecting the Parms icon in the tool
bar (if the Tool Bar is visible). See Figure 3.1.

&% IntegraH Programmer

mahle Settings

Figure 3.3 Edit Pull-down Menu

chprogrammers\integrahtupload.det

Below is a “‘quick guide’ list of the steps needed to program parameters for an Integra-H wireless modem:

e Plug the Integra-H’s SETUP Port to the Primary COM Port of the computer.

* READ the current program information from the Integra-H.

* Modify the parameters using the Setup Modem/Radio Parameters item under the Edit menu.
» Select OK at the bottom of the Setup Modem/Radio Parameters window.

*  WRITE the information to the Integra-H.
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3.3.1 Setup Modem/Radio Parameters

The parameter settings are modified from three screen tabs, the Modem, the Com/Analog, and the Radio. When all
of the parameters in each tab window have been adjusted, select the OK button to store the parameter information
into local memory and exit the parameter screen. Pressing the Default Parms button will set certain parameters
back to the factory default settings, see Section 3.3.1.4 for the default settings list. Pressing Cancel will exit the
parameter screen without modifying any parameters currently stored in local memory. s

Farms

3.3.1.1 Modem Setup Parameters
Figure 3.4a shows the initial Setup Modem/Radio Parameters screen with the Modem tab displayed.

‘T Setup Modem/Radio Parameters - |E'*

]/ ComiAnalog T Radio ]

—Modem Parameters:

Firmware: |iniqgm-l-i *!
System 1D: |1l]l]19

Serial No: |1 0016 - BGBP

ShortID: [16

Comment: |Remute Station 016

¥ Tx Online Diags —Unit Type: ——
. * Remote
Data Delivery: |AII vi ~ Master

Sleep Mode: |Disah|ed vi

Sync Count Wrap Mode:
Half Counts when 65535 = |

Default Parms | OK | Qam:ell

Figure 3.4a Parameter Setup — Remote Modem Screen

The Modem tab allows the user to set the System ID, Short ID, Comment text, Data delivery type, enable or disable
Tx Online Diagnostics, enable or disable Sleep Mode, select the Sync Count Wrap Mode, and set the unit type as
Master or Remote.

System ID: This number can be set from 1 to 65,535 and must be a unique number common to all units in the same
communication network. Setting the System ID to an even number will set the hopping frequency range to 902.200
—927.750 MHz, for a total of 512 channels separated by 50 kHz. Setting the System ID to an odd number will set
the hopping frequency range to 902.225 — 927.775 MHz (off-set by 25 kHz from the even set).

Short ID: A number from 1 to 254 that identifies an individual unit in a network. The Short ID can be changed
from this screen or via the radio parameter cloning option (see section 3.3.2).

Comment: This field is used for user-convenient descriptions (customer name, location, technical info, etc).

Comments can be text up to 24 characters in length, including spaces. The Comment field can be changed from this
screen or via the radio parameter cloning option (see section 3.3.2).
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Data Delivery: This field selects if data should be delivered to the COM Port. Designating a unit as Master or
Remote sets a flag in the header identifying the Unit Type of the originating station. Setting Data delivery to All
causes the unit to accept, on the receive side, all data transmissions. Setting Data Delivery to Selective causes the
unit to accept receive data only if it originates from a unit of the opposite Unit Type.

Unit Type: This field sets the unit as either a Master or a Remote station. A Master unit periodically transmits
synchronization information to each Remote unit in the communication network. Designating a unit as a Master or
Remote sets a flag in the header identifying the Unit Type of the originating station.

Sleep Mode: When Sleep Mode is enabled, the unit is always in low power consumption. When sleeping, the unit
cannot detect presence of carrier. Only asserting RTS on the COM or SETUP ports will wake the unit up. The
Remote unit will be ready to receive and decode data when it has acquired synchronization with the Master after a
wake-up. Synchronization can take anywhere from 19 to 154 seconds depending on the number of sub-bands
enabled. The unit will go back into Sleep Mode approximately one second after RTS is lowered.

Tx Online Diags: Transmission of online diagnostics may be enabled or disabled for any unit without affecting
their ability to communicate with other units in a network. Diagnostics are delivered locally to a unit’s own Setup
Port regardless of the Tx Online Diags setting.

Sync Count Wrap Mode: Selects one of three Sync Count modes used by the Sync Count Diagnostics. The
number of sync counts stored is limited to 65535 (FFFF hex). This mode determines what the counters should do
when one of the channel sync counts reaches 65535. Refer to Sections 3.5.6 & 4.5 for detailed information on the
Sync Count Diagnostics.

Zero Counts when 65535: Will zero all sync counters causing the count accumulation for
each channel to start at zero again.

Hold Counts when 65535: Will hold the each channel counter to the limit when it is
reached. The user must manually zero the counters to start the accumulation at zero again.

Half Counts when 65535: Will divide all channel counters in half when one counter
reaches the limit. The user must manually zero the counters to start the accumulation at
zero again.

Figure 3.4b shows the modem screen when the Master Unit Type is selected. A pop-up box will display, informing
the user to consider what System ID to use. To prevent the possibility of two or more different network systems
from having the same System ID, it is suggested that each unique system’s System ID be set to the Master Radio’s
serial number. The Calc System ID button will automatically set the System ID number to the radio’s serial
number.
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Modem I Cbm,’ﬁnadogT Radio

—Modem Parameters:
Firmware: Integra-H

System 1D: |1 o019

Serial No: |1 0019 - BGBC

Short ID: |T

Comment: |Master Station 019

o

Calc System 1D |

¥ Tx Online Diags Unit Type:
:  Bemote
Data Delivery: IAII *l = Master

Sleep Mode: IDisahIed vl IntegraH E

Sync Count Wrap Mode:
=

“When selecting a Master, the System 1D should be addressed.
Half Counts when 65535

Itis narmally based on the Master's Serial Mumber,

A
Default Parms | | OK I _Qa'm::ell

Figure 3.4b Parameter Setup - Master Modem Screen

3.3.1.2 Com/Analog Setup Parameters

Figure 3.5 shows the Communications and Analog Connection parameters screen used to set the communication
parameters for the Integra-H.

l] Setup Modem/Radio Parameters !H

tdodem |

Tx Control: ——

r RTS
& DOX

—Communication Parameters:

Radio

1_

DCD Control:

" Active
& Switched

-

DTE Baud Rate:

IBBI]I] ?l

DIE Data Format: |8 Bits. No Parity. 1 Stop =]
Data Fwd Timer: INDrmaI vl
Break: IIgnore Break LI
Deferred Rx-Data Delivery (mS):
<] o
—Analog 1 (Green): Analog 2 (White):
& Input ' Input

|

Default Farms | OK I Cancel |

Figure 3.5 Parameter Setup — Com/Analog Modem Screen
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The Com/Analog tab allows the user to set the Communication Parameters to match the parameters required by a
specific user’s Data Terminal Equipment (DTE).

Tx Control: These radio buttons select the mode in which a unit starts a transmission, Request To Send (RTS) or
Data Operated Transmission (DOX). The default mode is DOX, which causes the unit to begin a transmission as
soon as data is presented to the COM Port. The optional mode is RTS, in which the unit begins a transmission only
when the RS-232 RTS input pin of the COM Port is raised. The unit returns CTS in 4 mS and continues
transmitting until the RTS is dropped. Selecting RTS also activates the Switched option in DCD Control.

DCD Control: These radio buttons select how the RS-232 DCD (Data Carrier Detect) will act. Set to Active, DCD
will always be asserted. Set to Switched, DCD will follow the radio carrier sense and data sent to DTE. DCD
Switched mode is the most common mode used.

DTE Baud Rate: This field selects the port speed for the COM Port, independent of the Network Speed. The DTE
Baud Rates available are 1200, 2400, 4800, 9600, & 19200.

DTE Data Format: This field selects the format for the COM Port. All units in the network must use the same
DTE Data Format. Below lists the available formats.

8 Bits, No Parity, 1 Stop7 Bits, No Parity, 1 Stop

8 Bits, No Parity, 2 Stop7 Bits, No Parity, 2 Stop

8 Bits, Odd Parity, 1 Stop7 Bits, Odd Parity, 1 Stop
8 Bits, Odd Parity, 2 Stop7 Bits, Odd Parity, 2 Stop
8 Bits, Even Parity, 1 Stop7 Bits, Even Parity, 1 Stop
8 Bits, Even Parity, 2 Stop7 Bits, Even Parity, 2 Stop

Data Fwd Timer: This field selects the timing between data blocks in a transmission to accommodate some RTU's
special timing requirements. Selecting Normal will set the timer to 15 mS. Selecting Fast will set the timer to 5 mS.
Do not use the Fast setting for baud rates below 2400.

Break: This field selects what the unit does with break signals delivered to the COM Port. Selecting Ignore Break
causes the unit not to transmit or receive break signals. Selecting Transmit Break enables the unit to transmit and
receive break signals. Some protocols require break signals in their serial data strings.

Deferred Rx-Data Delivery: This field is used to set the period of time the unit waits until it starts delivering the
received data to the COM Port. The range is 0 to 255 mS in 1 mS intervals. For protocols susceptible to inter-
character delays, this will help keep them small.

Analog 1: Configures pin 3 (green wire) of the Power/Analog Connector as an input port to monitor an external
voltage (0 to 10 Volts).

Analog 2: Configures pin 4 (white wire) of the Power/Analog Connector as an input port to monitor an external
voltage (0 to 10 Volts).

See Section 2.4.4, “*Analog Connections’, for further explanation for using the analog input ports.
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3.3.1.3 Radio Setup Parameters

Figure 3.6 shows the Radio parameter adjustment screen. The Radio and Range numbers refer to the Integra-H
model and are not adjustable.

"i' Setup Modem/Radio Parameters !m

Modem T ComiAnalog T

—Radio Parameters:

Radio: I4|]99 vl
Range: IE vl

Carrier Sense:

4 [ »| -110dBm
Power Adjust:
4] [»] 30.0dBm

—Sub-Band Mask
[ Band01 W Band0O% [ Band09 W Band13
V" Band 0?2 [ BandO6 [ Bandl10 [ Band 14
[ Band 03 [ Band0O? [ Band11 [ Band 15
W Band 04 [ Band 08 W Band12 [ Band 16
MNote: If checked. these Frequencies will be Used:
Sub-Band 01 = 902200 MHz - 903.750 MHz

Set All | Clear All |

Default Parms | OK | Qam:ell

Figure 3.6 Parameter Setup — Radio Modem Screen

The Radio tab allows the user to set the carrier sense level, power out level, and sub-band frequencies.

Carrier Sense: Carrier is indicated when the receiver RSSI level crosses above the set level. Carrier Sense is used
for data recovery, in the interpretation of diagnostics, and to turn on the front panel CS LED. The threshold may be
raised to prevent false Carrier Sense operation in the presence of noise, intermodulation, or other sources of

interference. The Carrier Sense threshold can be adjusted level in 1 dBm increments from —130 dBm to —40 dBm.

Power Adjust: The Power Adjust slider is used to set back the output power of the Integra-H when used with
higher gain antennae or in close proximity of each other. The power can be set in 0.5 dBm increments from 20 dBm
(0.1 watts) to 30 dBm (1 watt).
Sub-Band Mask: The Sub-Band Mask section allows the user to choose the usable hopping frequencies in blocks
of 32 channels (1.55 MHZz) over the full 512 channel hopping band. A minimum of 2 bands must be selected to
comply with FCC regulations.

Set All: Will check all the sub bands for use.

Clear All: Will clear all check boxes. If less than two boxes are checked, the program will select
the lower band adjacent to the one selected, or select the first two bands if none are selected.

001-4099-101 3-8



3.3.1.4 Default Parameters

Pressing the Default Parms button will automatically set many of the radio parameters to a pre-determined factory
setting. The following list shows the default settings used:

Modem Screen:
Data Delivery — ALL
Sleep Mode — OFF
Tx Online Diagnostics Enabled (checked)
Unit Type - REMOTE
Sync Count Wrap Mode — Half Counts when 65535

Com/Analog Screen:
Tx Control - DOX
DCD Control - SWITCHED
DTE Baud Rate — 9600
DTE Data Format — 8 bits, No Parity, 1 Stop
Break - IGNORE BREAK
Deferred Rx-Data Delivery — 0

Radio Screen:
Carrier Sense — -110 dBm
Power Adjust — 30 dBm (1 Watt)
Sub-Band Mask — Sub-bands 2, 4, 5, 7, 10, 12, 13, & 15 enabled (checked)

3.3.1.5 Writing and Reading Parameters to/from the Integra-H Wireless Modem

After all radio parameters have been setup, select the OK button to store the information into local computer
memory. To load parameters into the Integra-H wireless modem, the user must initiate a Write Programmable
Settings command from the Edit menu (see Figure 3.3) or select the Write icon in the Tool Bar.

L0
Shrite

Once the parameters for an Integra-H wireless modem have been programmed, the user should save the parameter
information using the Save Data File As option in the File pull-down menu. The name and location of the file
(*.dat extension) will appear on the status bar at the bottom of the screen (see Figure 3.1).

The Read Programmable Settings command will read the parameters from the current radio and store the
information in local memory (see Figures 3.1 & 3.3). The parameters can then be viewed and/or edited with the
Setup Modem/Radio Parameters screens.

2,

Read

Important Note: It is recommended that a Read be done anytime an initial connection to the Integra-H Setup Port
is made and before accessing the Setup Modem/Radio Parameters screen. This can avoid writing erroneous
parameters to the connected unit.
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3.3.2 Radio Parameter Cloning

With the initial system radio parameters programmed, saved, and stored in local memory, other radios in the system
can be quickly programmed using the three cloning options under the Edit pull-down menu (see Figure 3.3): Clone
Programmable Settings, Clone As Master, and Clone As Remote.

Figure 3.7 shows the three clone parameter screens.

+* Clone Programmable Parameters m

Connect Serial Cable to Setup Port and
Supply Power

Cancel |

#* Master - Clone Programmable Parameters m

Connect Serial Cable to Setup Port and
Supply Power

Short1D: [19

Comment: |

Cancel |
4™ Remote - Clone Programmable Parameters E

Connect Serial Cable to Setup Port and
Supply Power

Short ID: |T

Comment: |

Cancel |

Figure 3.7 Parameter Cloning Screens

The Remote and Master cloning screens prompt the user for a unique Short ID and Comment for each new radio to
be cloned in the system, all other parameters will be programmed identically. Remember, only one radio should be
programmed as a Master per system. After selecting OK, the Short ID will increment by one in preparation for the
next unit to be cloned. Selecting Cancel will exit the cloning screen.

The basic Clone Programmable Parameters option will program the radio with all of the currently loaded
parameters except the Short ID, Comment, and Remote/Master type for that particular radio. This cloning option is
useful if the user wanted to change the DTE Baud Rate for a number of radios in a system. The Master radio would
be updated and programmed, then all of the remotes on that system could be cloned with the new DTE Baud Rate.
The Program Comment / ID option in the Edit menu (see Figure 3.3) will allow the user to change a radios Short
ID and Comment field without changing any other parameters, see Figure 3.8 (see page 3-11).
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" Program Comment / ID

Change Short ID and/or Comment
Press Program Button When Ready

Serial No: |1 0019 - BGBC

ShortID: [19

Program Short 1D |

Comment: |

Program Comment |

Figure 3.8 Program Comment /ID Screen
Type in the desired Short ID and/or Comment and select the associated Program button.

3.3.3 Version Request, Integra Reset, & Factory Defaults

Selecting Version Request from the Edit menu (see Figure 3.3) will display the radios current firmware version,
Serial number, Short ID, and Comment text. Select Close to exit the screen.

+ Yersion Request _ |0 I

Integra-H : 3.00.00
Serial Number = 10019 - BGBC
Short 1D =019
Comment = Bemote Station 019

Close I

Figure 3.9 Firmware Version Screen

Applying an Integra Reset, from the Edit menu (see Figure 3.3), tells the unit to perform a software reset. An
Integra Reset will initialize the modem’s memory as if the unit where powered on. This is not a substitute for
powering the unit off and on again when updating firmware (see Section 3.4, ‘Firmware Programming’).

Applying a Factory Defaults, from the Edit menu (see Figure 3.3), sets the radio parameters back to the initial
factory values, then resets the radio. It may be necessary to perform a Factory Defaults after loading in a new
firmware update (see Section 3.4).

Important Note: Applying a Factory Defaults will effect all of the user programmable parameters including the
System ID. Therefore, the parameter settings should be saved before issuing the command.

3.3.4 Sub-Band Mask Remote Programming

The Remotely Program Sub-Band Mask item in the Edit menu (see Figure 3.3) allows a user to re-program the sub-
band mask for all Remote units from the Master unit. Re-programming the sub-band mask remotely requires that
all network operations be suspended. The Remotely Program Sub-Band Mask screen is shown in Figure 3.10.
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+# Remotely Program Sub-Band Mask !E

Program Master and Remote Sub-Band Masks
Press Start Programming Button When Ready

—Sub-Band Mask

[T Band 01 v Band0O5 [ Band09 [ Band13
W Band02 [ BandO6 W Band10 [ Band 14
[ Band 03 W Band0O? [ Band11 W Band 15
" Band 04 [ Band0O8 [ Band12 [ Band 16

—Modem List

Master ID: r | Start Programming I
Bemote ID: b1 hd |
Close

Figure 3.10 Remote Sub-Band Mask Programming

All Master and Remote units, in the same network system, should initially be setup with identical sub-band mask
selections. If the Master unit sub-band mask is changed, without re-programming the sub-band mask of the Remote
units, the Remote units will go out of synchronization and may take a longer time to re-acquire synchronization.

Remotely programming the sub-band mask is performed with the computer’s Primary COM port connected to the
Master unit’s Setup port. Remotely programming the sub-band mask will not reset the Sync Count to zero on the
Remote units, refer to section 3.5.6, ‘Sync Count Diagnostic Display’.

When sub-band mask programming is complete, a message box will appear and show if any Remote units failed to
get programmed. The user will have the option to save a ‘log’ file containing the newly programmed sub-band
mask and the Remote unit status (success or failure). The default file name is RemProg.txt.

Sub-Band Mask: The Sub-Band Mask section allows the user to choose the usable hopping frequencies in blocks
of 32 channels (1.55 MHZz) over the full 512 channel hopping band. A minimum of 2 bands must be selected to
comply with FCC regulations.

Modem List: List of Master and Remote unit ID’s set up in the Diagnostic 1Ds and Alarms screen. Refer to
Section 3.5.1. This list must contain all of the Remote units on the network.

Start Programming: When the desired Sub-Band Mask is selected, press this button to start the remote
programming process.

Important note: If the sub-band mask of the Master unit is changed, at least one sub-band from the previous set

should be kept enabled to insure that the Remote units will regain synchronization in the event that the sub-band
mask change command was not properly received.
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3.4 Firmware Programming

The Integra-H is designed to allow users to update the firmware code when new versions become available.
Selecting the Program Code menu item displays the firmware programming options, see Figure 3.11.

IE 2 [e\proorammers\integrahidetiuplaad dat

Figure 3.11 Program Code pull-down menu

Users can obtain new firmware version files by contacting Technical Services. The firmware file (*.bin extension)
should be copied to a convenient directory on the computer’s hard drive. Re-programming the firmware requires
that the radio be powered off and then on again, therefore, the communication network will be off-line while radios
are upgraded. In most cases, all radios in the communication network will need to be upgraded to the same
firmware version for proper operation.

Important note: Usually upgrading firmware should not effect any programmed parameter settings, however, it is
recommended that the current data file in all radios, or at least the Master radios, be saved. Select the Save Data
File As option in the File menu pull-down (see Figure 3.1) prior to updating the firmware.

From the Program Code menu pull-down, click Select Modem Code File. Go to the directory in which the new
firmware file is stored and select (double-click) the file, then select Open (be sure the correct file appears in the
File name: field).

Once the file is loaded select Program Firmware, from the Program Code menu pull-down. Follow the on-screen
instructions to complete the firmware upgrade.
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3.5 Diagnostics and Software Utilities

The Online and Offline Diagnostics and software utilities can be accessed from the Utilities pull-down menu, see
Figure 3.12. Tests that a user can perform to monitor network reliability and aid in network troubleshooting are
listed below:

* Online Diagnostics: Available while network applications are running.
» Offline Diagnostics: Requires network operation to be suspended.

» Offline Link Test: Used to test the link between two units, the local unit that the computer is con-
nected to and a remote unit. Requires network operation to be suspended.

» Spectrum Analyzer: Will graphically display a unit’s receive signal strength for each channel in the
entire hopping band. Requires network operation to be suspended.

» Sync Count: Will graphically display the number of times, per hopping channel, the Remote unit
receives a valid synchronization word from the Master unit. Requires network operation to be sus-
pended.

&8 IntegraH Programmer

C
Figure 3.12 Utilities pull-down menu

ciprogrammerstinegrahldatiuplosd.dat
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3.5.1 Setting Diagnostic IDs and Alarms

The Diagnostic IDs and Alarms screen sets up the ID List to be used with the Offline Link Test, Offline
Diagnostics, and Online Diagnostics, as well as the alarm limits for use with the Online Diagnostics.

'T Diagnostic IDs and Alarms

File: c:\programmersintegrahifilter.dia

—ID Entry and List

ID Entry: I15 Add ID |
ID List |19 v| Delete ID I

—Alarms for Online Diagnostics

Low RSSI: I—1 oo High RSSI: -30
Low Temp: -30 High Temp: IEI]

Low Batt: |1 0.0 High Batt: |1 6.0
Low Fwd Pwr: !I]_? High Fwd Pwr: !1_I]

Cancel |

Open | Save | SageAsl

Figure 3.13 Diagnostic IDs and Alarms Screen

ID Entry and L.ist

ID Entry: Allows the entry of a Short ID to be added to the ID List. The range of this field is 1 to 254. A Short ID
is added to the ID List by typing in the ID number and selecting the Add 1D Button.

ID List: Allows the selection of a Short ID from the ID List to be deleted. A Short ID is deleted from the ID List by
pressing the Delete 1D Button.

Alarms

Alarms are used together with the Online Diagnostics.

Low / High RSSI: These represent the Low and High limits for the RSSI diagnostics (in dBm).

Low / High Temp: These represent the Low and High limits for the Temperature diagnostics (in °C).

Low / High Batt: These represent the Low and High limits for the Battery Voltage diagnostics (in Volts).
Low / High Fwd Pwr: These represent the Low and High Limits for the Forward Power diagnostics (in Watts).

The top line on the screen displays the current diagnostics file. Different diagnostic alarm files can be stored and
recalled, but only one alarm limits set can be active during Online Diagnostics.

Open Button: This button allows for the restoring of Diagnostic IDs and Alarms from a previously saved file.
Save Button: This button allows for the saving of the Current Diagnostic IDs and Alarms to the current file.

Save As Button: This button allows for the saving of the Current Diagnostic IDs and Alarms to a different file than
the current file.
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Selecting OK will bring up a window asking if the user would like to Save before Closing; select “Yes’ to activate
and save the new limits to the current file, select ‘“No’ to not activate and save the new limits.

3.5.2 Online Diagnostics Display

Each unit in the network transmits Online Diagnostics before the user data is transmitted. All units must be
programmed with the Online Diagnostics parameter, found on the Setup Modem/Radio Parameters screen (see
Section 3.3.1, Figure 3.4). The unit the computer is connected to will output diagnostic information as they are
received. Using Online Diagnostics does not require network operation to be suspended. Figure 3.14 shows a
sample Online Diagnostic screen output. Refer to Section 2.6, ‘Online Diagnostics’ for further information.

Short | Temp | Batt | Local |FwdP [RevP |Remote | Bx | Time
ID [(84] V) R551 | (W) RSS| |Quality

160 +42 - 132 -| -87 - 096 - Good -83/- 100%  16:09:14 03/19/2001| «

19 +40 - 118 -| -65- 098 - Good -83 - 100% 16:09:15 0371972001

160 +42 - 132 -| -66 - 096 - Good -68/- 100 %  16:09:16 0371972001

161 +42 - 132 -| -69 - 096 - Good -69 - 100 %  16:09:17 0371972001

19 +40 - 118 - -71 - 096 - Good -69/- 100 %  16:09:18 0371972001

161 +42 - 132 -| -72 - 096 - Good -69/- 100 %  16:09:19 031972001

19 +40 - 118 -| -66 - 098 - Good -69/- 100 %  16:09:19 0371972001

16/ +42 - 132 -| -69 - 096 - Good -73 - 100%  16:09:20 037192001

19 +40 - 119 -| -69 - 096 - Good -73/- 100 %  16:09:21 0371972001

16/ +42 - 132 -| -66 - 096 - Good -69/- 100 %  16:09:22 03/19;/2001

160 +42 - 132 -| -6b - 096 - Good -71/- 100 %  16:09:23 0371942001

19 +40 - 118 -| -65 - 096 - Good -71/- 100 %  16:09:24 037192001

160 +42 - 132 -/ -71 - 096 - Good -73/- 100 %  16:09:24 0371972001

19 +40 - 118 -| -69 - 1.00 - Good -73/- 100 %  16:09:25 0371972001

160 +42 - 132 -| -69 - 096 - Good -72/- 100 %  16:09:26 03/19/2001

19 +40 - 118 -| -65- 1.00 - Good -72/- 100 %  16:09:27 03/19;2001|__|

-

~Fiter ———— Display: — |gcallD: 19  FilterDList [16 ~
& Off (All IDs)
D List  Slotted (by ID) Progress: | ‘
I

selected D I” Pause Clear ' Save i Close I

Figure 3.14 Online Diagnostics Display Screen

The Online Diagnostics are subject to alarm conditions, defined in the Diagnostic IDs and Alarms screen (see
Figure 3.13). When Online Diagnostics are received and a diagnostic field falls outside the Alarm Limits, a “<”
character will designate a value less than the Low Alarm and a “>" character will designate a value greater than the
High Alarm. A “- “to the right of a field indicates that the value is within the alarm limits. The Online Diagnostics
chart will hold the last 4096 lines of unit data recorded.

The following are the available Online Diagnostics:

Short ID: Displays the Short ID of the unit transmitting the diagnostics.

Temp: Displays the internal case temperature (in Celsius) of the unit transmitting the diagnostics.

Batt: Displays the supply voltage (in Volts) of the unit transmitting the diagnostics.
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Local RSSI: Displays the RSSI (in dBm) of the “local” unit (unit connected to the computer) transmitting the
diagnostics. This is the RSSI sampled during the last transmission the unit received.

FwdP: Displays the forward power (in Watts) of the unit transmitting the diagnostics.

RevP: Displays the relative measure of reverse (reflected) power of the unit transmitting the diagnostics. This is
represented as 'Good' if the reverse power is within acceptable limits and is represented as 'Bad' if the reverse
power is too high. See Sections 2.8.9 & 2.8.10 for further reverse power information.

Remote RSSI: Displays the RSSI (in dBm) of the “remote” unit listed. If the unit listed is the “local” unit, then this
is the RSSI level of the last “remote” unit the “local” unit received data from. This RSSI level is an indication of
the signal strength received from the “local” unit (unit connected to the computer).

Rx Quality: Displays the receive quality (in %) of the unit. This is the number of correctly decoded transmissions
received by the unit (in the last 15) divided by the number of total transmissions detected by the unit.

Time: Time stamp of when the diagnostics were received.

Filter: Allows the filtering of Short IDs. The following options are available:
Off (All IDs): No IDs will be filtered out.
ID List: Only the IDs in the Filter ID List will be shown.
Selected ID: Only the selected ID in the Filter ID List will be shown.

Filter ID List: The list of Remote I1Ds setup in the Diagnostic 1Ds and Alarms Screen (see Section 3.5.1).
Diagnostics for the unit ID number shown will be displayed when using the Selected ID filter.

Display: Allows for the formatting of the data on the screen. The following options are available:
Scroll (by time): Displays the diagnostics as they are received.

Slotted (by ID): Sorts the diagnostics by Short ID. Using this option, each Short ID will have
only one row of diagnostics, showing the most recent.

Progress: This Panel shows the progress of sorting the diagnostics, if a filter was changed.

Pause: This button pauses the reception of diagnostics information. The user can then scroll through the list of
previous data times.

Clear: This button clears the display and the current Online Diagnostics that have been acquired.
Save: This button saves the recently acquired Online Diagnostics to a file.

Online Diagnostic example:

Master Unit: Short ID =19
Remote Unit: Short ID = 16

The PC’s Primary COM Port is connected to the Setup Port of the Master radio (unit #19). Therefore, unit 19 is the
“local” station and unit 16 is the “remote” station.
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nOnline Dingnostics ________________________H|

Short | Temp | Batt | Local |FwdP |RevP |Remote | Rx Time
ID <) ) | RSSI | W) RSSI |Quality
16 +42 - 132 - -65 - 0.96 - Good -83/- 10002  16:09:14 03/19/2001| =
19 +40 - 11.8 - -65 - 0.98 - Good -63/- 100%  16:09:15 03/19/20M

In the first line of data above (reading from left to right):

The unit’s Short ID is 16 (“remote” unit).

Unit 16 has a case temperature of +42 °C.

Unit 16°s supply voltage measures 13.2 VDC.

The last data transmission received by unit 19 (*local” unit) had an RSSI signal level of —65 dBm.
The last transmission from unit 16 was 0.96 watts.

The reverse power indicates that the reflected power is within Good operating limits.

The last data transmission received by unit 16 (“remote” unit) from unit 19’s transmission had an
RSSI signal level of —83 dBm.

The percentage of correctly decoded transmissions received by unit 16, in the last 15, is 100%.

In the second line of data above (reading from left to right):

The unit’s Short ID is 19 (“local” unit).

Unit 19 has a case temperature of +40 °C.

Unit 19’s supply voltage measures 11.8 VDC.

The last data transmission received by unit 19 (*local” unit) had an RSSI signal level of —65 dBm.
The last transmission from unit 19 was 0.98 watts.

The reverse power indicates that the reflected power is within Good operating limits.

The last data transmission received by unit 16 (“remote” unit) from unit 19’s transmission had an
RSSI signal level of —83 dBm.

The percentage of correctly decoded transmissions received by unit 19, in the last 15, is 100%.

3.5.3 Offline Diagnostics Display

Offline Diagnostics are returned from local or remote units. Using Offline Diagnostics requires network operation

to be suspended. Figure 3.15 shows the Offline Diagnostics screen when first opened.

i—'_.‘& Offline Diagnostics E
—Diagnostics: —Modem Select -
Unit ID: - || # Local ID: i1 9
RS5S5I1 Level: — dBm —
Battery Voltage: — v | © Bemote ID: | 16 :TI
Temperature: — C | | — Diagnostic Select:
Forward Power: — W # Selected Bemote |2
Reverse Power: Yy o AlllBemotes in st
Analog Input 1: — -
Analog Input 2: i
et i Powerin dBm [
Preamble Good: =
Preamble Total: = Stop |
Progress: | Save Close |

Figure 3.15 Offline Diagnostics Display Screen
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The Offline Diagnostic parameters are:

Unit ID: The Short ID of the unit diagnostics information was received from.
RSSI Level: Received Signal Strength Indication (in dBm).

Battery Voltage: The measured supply voltage to the unit.

Temperature: The internal case temperature of the unit (in Celsius).
Forward Power: The unit’s last transmitted forward power (in Watts).

Reverse Power: The unit’s ‘relative’ reverse power indication (in Watts), see Sections 2.8.9 & 2.8.10 for detailed
information on reverse power reading.

Analog Input 1: Voltage on the External Analog 1 Input (Green wire) from the Power / Analog Connector (in
\olts)

Analog Input 2: Voltage on the External Analog 2 Input (White wire) from the Power / Analog Connector (in
\olts)

Preamble Good: The number of correctly decoded transmissions received in the last 15. Used with Preamble
Total, this serves as an indication of how well the unit is receiving data.

Preamble Total: The number of total transmissions detected, from a maximum of 15. Used with Preamble Good,
this serves as an indication of how well the unit is receiving data.

Local ID: This radio button selects the “local” unit (the unit the computer is connected to) to get diagnostic
information from. The Short ID for this unit is shown.

Remote ID: This radio button selects the “remote” units to get diagnostic information from. The remote unit(s) is
selected from the list of Remote IDs which are setup in the Diagnostic IDs and Alarms Screen, see Section 3.5.1.

Diagnostic Select

Selected Remote ID: This radio button allows for gathering of Offline Diagnostics from the
selected Remote ID unit only.

All Remotes in List: This radio button allows for gathering of Offline Diagnostics from all the
“remote” units in the list of Remote IDs and the “local” unit as well.

Power in dBm: The forward and reverse power will be displayed in dBm when this check box is selected.

Get Diags: This button sends out the Offline Diagnostics command. If the Local ID radio button is selected, the
command is sent to the unit that is connected to the computer. If the Remote ID and Selected Remote ID radio
buttons are selected, the command is sent to the selected Remote ID unit. If the Remote ID and the All Remotes in
List radio buttons are selected the command is sent to all units in the list of Remote IDs.

Stop: This button stops any more Commands for Offline Diagnostics from being sent out.

Save: This button saves the recently acquired Offline Diagnostic’s information to a file.

Progress: This bar shows the progress of getting Remote Diagnostics.
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3.5.4 Offline Link Test Display

The Offline Link Test is used to test the link between two units, the local unit the computer is connected to and a
remote unit. Blocks of data are transmitted to the remote unit, which decodes and returns them back to the local
unit. The transmitted and received blocks of data are compared and the ratio of the results is calculated. Using
Offline Link Test requires network operation to be suspended. Figure 3.16 shows the Offline Link Test screen when
first opened.

%3, Offline Link Test _ 1] x|

—Remote Select:

Local ID: I‘l!]i  Statt | Clear |

Pg—'_iusel Save |

Remote ID: |16 -

Blocks Tx'ed to Remote: ! 0
Responses from Remote: | 0
Blocks Rx'ed from Remote: | 1]

Link Quality to Remote: ! 0.000 %

Link Quality from Remote: 0.000 %
Owverall Link Quality: i 0.000 %%
# of Blocks to Send: 100

Block Delay (s):
« | »| DODS Close |

Figure 3.16 Offline Link Test Screen

Local ID: This is the Short ID of the unit the computer is connected to. This is the “local” unit.

Remote ID: This combo box selects the Remote ID unit to perform the Link Test with. This is the “remote” unit.
The list of Remote IDs are setup in the Diagnostic IDs and Alarms Screen, see Section 3.5.1.

Blocks Tx'ed to Remote: Displays the number of blocks of data that have been transmitted to the remote unit.
Responses from Remote: Displays the number of responses heard from the remote unit.

Blocks Rx'ed from Remote: Displays the number of blocks of data that have been received from the remote unit
by the local unit.

Link Quality to Remote: Displays the receive quality of the remote unit. This is the number of correctly decoded
transmissions received by the remote divided by the number of total transmissions detected by the remote (in %).

Link Quality from Remote: Displays the ratio of blocks of data received by the local unit to blocks of data
transmitted from the remote unit (in %).

Overall Link Quality: Displays the overall link quality, by combining the previous two quality ratios. This is the
ratio of blocks transmitted by the local unit to blocks received by the local unit (in %).

# of Blocks to Send: The number entered will be the number of blocks sent by the local unit before the test stops.
The test will run indefinitely if 0 is entered.

Block Delay (s): Sets the delay between the transmission of blocks of data, in 0.25 second intervals, from 0.00 to
10.00 seconds.
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Clear: This button will clear the display of blocks transmitted, responses received, blocks received, and all link
quality percentages.

Start: This button is used to start the test.
Pause: This button is used to pause the test. The test will resume when Start is pressed again.
Save: This button is used to save the results of the Offline Link test to a text file.

3.6 Spectrum Analyzer Display

The Spectrum Analyzer feature of the Integra-H FPS gives a current snap-shot of the spectral purity of the full
hopping frequency band received by a selected unit. Using the Spectrum Analyzer requires network operation to be
suspended. Figure 3.17a shows an example of a full spectrum plot measured from local Master unit 15. The line
marker is positioned on channel 344 (919.350 MHz), which is showing an RSSI reading of —-107 dBm.

L’g_. Spectrum Analyzer !B

-80
R55l

-40
(dBm)

-100

Channel: 344 Sub-Band = ALL 4 | | LI
RSS5I: -107
Channel 344 = 919.350 MHz Sub-Band ALL = Channels 001 - 512
—Modem Select ————— Sub-Band ALL = 902.200 - 927.750 MHz
& local ID:; |15 MNoise Fluur:LI J LI -120 dBm

~ : | I
Bemote ID: |19 = Get Spectrum I Stop | Close |

Figure 3.17a Spectrum Analyzer Display Screen - ALL

Figure 3.17b shows an example of a sub-band spectrum plot taken from the same plot in Figure 3.17a. The channel
line marker is positioned on channel 344 (919.350 MHz), which is showing an RSSI reading of -107 dBm. This
channel is in sub-band 11, which contains channels 321 to 352 (918.200-919.750 MHz).

001-4099-101 3-21



L’g_. Spectrum Analyzer !B
-50
-B0
=70
-850
RSSI
40
(dBm)
-100
-120
-130
320 322 324 326 328 330 332 334 336 33| 340 342 349 346 348 360 352
Channel
Channel: 344 Sub-Band=11 | 2
RSSI: -107
Channel 344 = 919.350 MHz Sub-Band 11 = Channels 321 - 352
—~Modem Select —————— Sub-Band 11 = 918.200 - 919.750 MHz
& Local ID: |15 Noise Fluur:LI J LI -120 dBm
- “ | I
Hewas B 19 hd Get Spectrum I Stop | Close |

Figure 3.17b Spectrum Analyzer Display Screen — Sub-Band 11
The spectrum analyzer parameters are:
Modem Select

Local ID: Selects the local unit (the unit the computer is connected to) to get the spectrum
measurement from.

Remote ID: Selects the Remote ID unit to get the spectrum measurement from. The list of Remote
IDs are setup in the Diagnostic 1Ds and Alarms Screen, see Section 3.5.1.

Sub-Band =: The Sub-Band slider is used to display any one, or all, of the 16 sub-bands spectrum measurement
plots. The Channel range and Frequency range of the displayed plot is shown below the Sub-Band slider.

Noise Floor: The Noise Floor slider is used to set a visual RSSI threshold or “noise floor”. For the sweep in
Figures 3.17a & b, the noise floor is set to —120 dBm. Any RSSI levels above —120 dBm can easily be
distinguished in the full spectrum plot. The noise floor indicator is manually set.

Channel Marker: Clicking anywhere on the plot chart will display the channel marker. The channel marker can be

moved across the plot by holding down the left mouse button while the mouse pointer is on the marker line. The
marker channel position, RSSI level, and channel frequency is displayed on the bottom left of the chart.

001-4099-101 3-22



Get Spectrum: Selecting this button will start the spectrum sweep using the selected unit. During this time the unit
will be offline, sweeping through all of the channels in the hopping band. If the unit is a Master, Remote units will
go out of sync for the sweep time period, but should re-acquire sync shortly after the sweep is complete.

Stop: Selecting this button will stop the sweep and return the radio to normal operation.

Important Note: It is recommended that the Master radio be used to perform a spectrum sweep. If a sweep is
performed using a Remote unit while the Master is transmitting sync information, the Remote unit will likely
detect some of the Master’s sync transmissions.

3.6.1 Sync Count Diagnostic Display

Figure 3.18a shows the initial Sync Count Display screen with the selected Remote ID unit set to 16. When the Get
Sync button is pressed, Remote unit 16 will transfer its sync count information to the “local” Master unit 19 (which
is the unit connected to the computer) and the information will be displayed. Sync count information is only
obtainable from Remote units. Master units transmit the sync information, and therefore, will not have a ‘receive’
sync count.

L‘}, Sync Count !B

10

0

1] 100 200 300 400 500
Channel
s iepioy Mods Channel: 1 Sub-Band = ALL | | o
# Display Count Sync Count: 0
' Display % Channel 1 = 902.200 MHz Sub-Band ALL = Channels 001 - 512
—Modem Select——————— Wrap Count Sub-Band ALL = 902.200 - 927.750 MHz
© Local ID: I19 | 0 Smallest: ] Largest: ]
o
Bempie W16 ll Save | Zero Counts | Get Sync I Stop Close

Figure 3.18a Initial Sync Count Display Screen

Figure 3.18b shows the display after the sync count information has been read from Remote unit 16. For this
example, the largest count was 1124 for the 8 sub-bands in use. The channel marker can be used to select any
channel and display its sync count, channel number, and frequency.

001-4099-101 3-23



L’} Sync Count !m

2000
1500
oo
1000
500
0
0 100 200 300 400 500
Channel
Gl e Channel: 1 Sub-Band = ALL | | o
[ Py Bount | Sync Count: . Sub-Band ALL = Channels 001 - 512
" Display % Channel 1 = 902.200 MHz ksl g e
~Modem Select Wrap Count.  Sub-Band ALL - 902.200 - 927.750 MHz
© Local ID: I19 | 0 Smallest: ] Largest: 1124
|
Eempie LI 16 ll Save | Zero Counts | Get Sync I Stop | Close

Figure 3.18b Sync Count Display Screen — ALL Sub-Bands (8 active)
Sync Count Diagnostic display parameters are:
Display Mode

Display Count: Displays the actual count values read from the Remote unit.

Display %: Displays the count results as a percentage of the largest count value read from the
Remote.

Modem Select

Local ID: Selects the local unit (the unit the computer is connected to) to get the sync count from.
The “local” unit can be either a Master or Remote station, but sync data is only obtainable from a
Remote unit.

Remote ID: Selects the Remote ID unit to get the sync counts from. The list of Remote IDs are
setup in the Diagnostic IDs and Alarms Screen, see Section 3.5.1.

Sub-Band =: The Sub-Band slider is used to display any one, or all, of the 16 sub-band sync count plots. The
Channel range and Frequency range of the displayed plot is shown below the Sub-Band slider.

Smallest & Largest: Displays the smallest and largest sync count number received for the displayed plot. Will
display in percentage if the Display Mode is set to Display %.
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Channel Marker: Clicking anywhere on the plot chart will display the channel marker. The channel marker can be
moved across the plot by holding down the left mouse button while the mouse pointer is on the marker line. The
channel position, channel sync count, and channel frequency of the marker is displayed on the bottom left of the
chart.

Get Sync: Selecting this button will gather the sync count numbers from the selected unit. During this time the unit
will be offline.

Wrap Count: Displays the number of times the sync counter has reached 65535 or “wrapped” when either the
Zero Counts when 65535 or Half Counts when 65535 Sync Count Wrap modes are selected.

Stop: Selecting this button will stop the sending of sync data and return the radio to normal operation.

Zero Counts: Sets the sync count of the selected unit to zero. All sync count information will be lost unless the
data is saved to a file.

Save: Save the sync count data to a file.

3.7 Other Software Utilities

3.7.1 Port Statistics

The Port Statistics screen, Figure 3.19, shows some statistics of the computer's serial COM Ports (Primary and
Secondary).

T—’g_. Port Statistics !m

T oecondany Port - Come
RTS ' DTR [

CTs [ DSR [ DCD [

—PErimany Port- Conl
BRTS [ DIR I

CTs [ DSR [ DCD [

Dribble Bytes: | 1]
Clear Stats |

Bytes Tx'ed: I 1] Bytes Tx'ed: | n
Bytes Rx'ed: | 1] Bytes Fox'ed: | n
Framing Em:lrsi 1] Framing Errursi n

Dribble Bytes: | 1]
Clear Stats |

Figure 3.19 Port Statistics Screen

RTS: Shows the current state of the RTS (request-to-send) Line. RTS is an output from the PC.
DTR: Shows the current state of the DTR (data-terminal-ready) Line. DTR is an output from the PC.
CTS: Shows the current state of the CTS (clear-to-send) Line. CTS is an input to the PC.

DSR: Shows the current state of the DSR (data-set-ready) Line. DSR is an input to the PC.

DCD: Shows the current state of the DCD (data-carrier-detect) Line. DCD is an input to the PC.
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Bytes Tx'ed: Shows the number of bytes (characters) that have been transmitted since the port was last opened.
Bytes Rx'ed: Shows the number of bytes (characters) that have been received since the port was last opened.
Framing Errors: Shows the number of Framing Errors that have been received since the port was last opened.

Dribble Bytes: Shows the number of Extra (not expected) bytes (characters) that have been received since the port
was last opened.

3.7.2 Channel Converter

The Channel Converter utility will calculate the operating frequency of a given channel and visa versa. The 25kHz
offset frequency will be displayed if the System ID is an odd number.

L%Chﬂnnel Converter — O X
Channel: 1344 :

Frequency: 1919.350000 Calc Chan |

System ID: i255l] Close

Channel 344 -> Sub-Band 11
Sub-Band 11 = Channels 321 - 352
Sub-Band 11 = 918.200 MHz - 919.750 MHz

Figure 3.20 Channel — Frequency Converter Screen
3.7.3 dBm Converter

The dBm converter utility converts dBm to Watts and visa versa. Input dBm or Watts and select the appropriate
Calc button. The dBm converter can be used to determine the correct power setting when using an antenna with
directional gain greater than 6 dBi. Refer to Section 1.10.2, “Antenna Connection”.

L% dBm Converter !E

dBm: I 29.7 Calc Watts |
Waltts: | 0.94 - :

Close |

Figure 3.21 dBm — Watts Converter Screen

The following equations are used for the conversions:

1(dBm/10)

Watts = ———
1000
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3.7.4 ASCIlI and HEX Terminals

The Terminal Screens allow the user to select an ASCII or Hexadecimal Terminal Screen for the Primary and
Secondary COM Ports that were configured in the Port Settings screen (see Section 3.2). The data will be sent
according to the port configuration that was setup in the Port Settings screen.

% Primary ASCIl Terminal [_ o] x|
Rx Data: ™ Packet #'s
a
H
Tx Data:
|
| |
|
I | Pguse| Send I Clear Bx | Clear Tx | Close |

Figure 3.22 ASCII Terminal Display Screen

Data terminals can be used to send and receive ASCII or HEX strings between two units. The terminals can also be
used to monitor data on a units setup port (such as Online Diagnostics).

ASCII Terminal

Primary: Selects an ASCII Terminal screen to send and receive ASCII data on the primary COM port that was
setup in the Port Settings screen.

Secondary: Selects an ASCII Terminal screen to send and receive ASCII data on the secondary COM port that was
setup in the Port Settings screen.

Hex Terminal

Primary: Selects a Hexadecimal Terminal screen to send and receive Hexadecimal data on the primary COM port
that was setup in the Port Settings screen.

Secondary: Selects a Hexadecimal Terminal screen to send and receive Hexadecimal data on the secondary COM
port that was setup in the Port Settings screen.
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Section 4

Network Troubleshooting

4.1 Troubleshooting Overview

Many of the diagnostic utilities in the Integra-H Field Programming Software, described in Section 3, can be used
to find problems with individual units within a network. Below is a list of diagnostic tools to help determine the
cause of many network communication problems.

Used while network applications are running:

* Monitor power out and receive RSSI levels using the Online Diagnostics feature described in Section
2.6 and 2.8.

Used while network applications are offline:

» Local and Remote Offline Diagnostics to check “suspect” remote units for proper operating limits as
described in Sections 2.7 and 2.8.

» Offline Link tests to check the communication link between two units.

» Spectrum Analyzer sweeps to determine the current spectral purity across the full hopping band.

» Sync Count analysis to look at the long term past performance of a remote unit’s ability to maintain
sync on individual hopping channels used by the system.

4.2 Online and Offline Diagnostics

This section describes how to interpret Online and Offline diagnostic information. Refer to Sections 2.6, 2.7 and
3.5 for information on monitoring diagnostic data.

Online diagnostics may be used for monitoring an operating network with the user’s applications running. The
diagnostics are carried along with user data transmissions and do not interfere with normal operations.

Maintaining a file registry, containing diagnostic readings for a network, is an effective tool for comparing test
readings and trend monitoring (system history). Variances in the data can alert technicians to changes in network
status.

lj ondiags.txt - Notepad !Bm
File Edit Search Help
| ID Temp A Batt A RSSI A Fwd A Rev RemRSSI A Quality Time Date =
19 +30 - 12.2 - -0 - 0.96 - Good -69 - 100 % 12:58:38 03/07/2001
16 +30 - 13.3 - -66 - 0.94 - Good -69 - 100 % 12:58:41 03/07/2001
19 +30 - 12.2 - -8 - 0.96 - Good -69 - 100 % 12:58:57 03/07/2001
16 +32 - 13.3 - 67 - 0.94 - Good -7 - 100 % 12:59:00 03/07/2001
19 +30 - 12.2 - -71 - 0.96 - Good -T0 - 100 % 12:59:04 03/07/2001
19 +30 - 12.2 - =71 - 9.96 - Good -7 - 100 % 12:59:14 03/07/2001
16 +32 - 13.3 - =77 - 0.94 - Good =] o= 100 % 12:59:17 03/07/2001 L’

Figure 4.1 Online Diagnostic Text File

Figure 4.1 shows a sample from the saved Online Diagnostic text file. The default file name is ondiags.txt. The file
is space delimited and can be imported into various spreadsheet or database programs. The maximum number of
data lines buffered is 4096, after which current data will be added and older data will be dropped.
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& offdiags.bd - Notepad !EIE
File Edit Search Help
07:46:10 D03/22/2001 =
ID RS83I BattV TempC Fwdll Revd Good Total
19 =72 1Z2.3 38 1.00 0.22 15 15
16 =70 133 40 D0.8%a D.Z2 15 15
17 -63 133 34 0.%96 0.14 L5 15
08:00:28 03/22/2001
ID RS53I BattV TempC Fwdll RevW Good Total
19 -74 12.3 38 0.96 0.22 15 15
16 -74 133 40 D0.98 D.Z2 15 15
17 -6a0 133 34 0.94 0.14 15 15
| &

Figure 4.2 Offline Diagnostic Text File

Figure 4.2 shows a sample from the saved Offline Diagnostic text file. The default file name is offdiags.txt. In this
example the offline diagnostic data taken on 07:46:10 was appended to the data taken on 08:00:28 to compare unit
data over time.

Refer to Table 4.1 below for diagnostics, descriptions, and tolerances.

Table 4.1 Diagnostic Information

Tolerance
Between 1 and 255

Field Name
Unit ID

Description

Identifies the unit whose diagnostics are
displayed

RSSI Level & remote RSSI

Remote RSSI is only valid for the Online
Diagnostics display. Refer to Section 3.5.2

Normally £3dB accuracy. A good receive
signal level should be higher than
—90dBm.

Battery Voltage

Unit’s main DC power measured in tenths
of a volt. Do not exceed 16 VDC.

Operating limits are:10.0 to 16.0 VDC
12-14 VDC nominal

Temperature

Internal Case temperature

Operating Limits are:-30°C to +60°C

Forward Power

Approximate measure of transmit RF
power. This level can be set from 0.1to 1.0
watts.

0.02 watt resolution typically reads 0.96
watts at full power, but can range from
0.90 to 1.00.

Online Reverse Power

Reflected power indicator.

For Online Diagnostics: “Good” (0) if
reflected power is within limits, “Bad” (1)
if reflected power is too high. The thresh-
old is set to approximately % of Forward
power.

Offline Reverse Power

Relative measure of reflected power.

Value in watts is close to 0.2, but values up
to 0.4 may be encountered in properly
operating systems. Refer to Section 2.8.10.

Analog Input 1

Analog input from 0 to 10 VDC with 8 bits
of resolution.

010 10.0 VDC

Analog Input 2

Table continued on page 4-3

Analog input from 0 to 10 VDC with 8 bits
of resolution.

0t0 10.0 VDC

001-4099-101




Table 4.1 Diagnostic Information

Field Name

Description

Tolerance

Preamble Good

Number of correctly decoded transmis-
sions in the last 15. In a multiple Remote
system, this ratio will be an aggregate of

15/15 = 100%. Lower values (8/15), cou-
pled with strong receive signals, usually
mean local interference at the remote site.

all stations heard.

Used with the number in the “Good” field
to establish a percentage indicative of
reception quality.

Preamble Total

4.3 Link Test

The Link Test tests the network data link status by sending a number of transmissions from a “local” unit to a
“remote” unit. The “remote” unit then transmits the received data back to the “local” unit. A ratio of good to bad
signals received is then computed and the results displayed as a Link Quality percentage for both individual links
and the overall link. Refer to Section 3.5.4 for additional information on Link Test parameters.

Important note: Shut down your SCADA application before performing a Link Test. Other data transfers occurring
on the system will produce erroneous results.

qj LinkTst bt - Notepad !Em
File Edit Search Help
LocalIl ERemoteID BlocksTx'ed Responses EBlocksBEx'ed ToRemote% FromwRemotei Owveralli Time Date &
19 16 100 100 100 100.000 100.000 100.000 15:11:26 03/20/2001
19 16 100 100 100 100.000 100.000 100.000 0O7:48:52 0372172001
12 1% 100 100 100 100.000 i00.000 100.000 0O7:50:08 03/21/z001
o

Figure 4.3 Offline Link Test Text File

Figure 4.3 shows an example of a link test output file. The default file name is LinkTst.txt. The example file shows
appended data for three separate link tests performed. Link quality percentages should typically range form 99% to
100% for properly operating systems.

Combining the Link Test with Offline Diagnostics can be a very useful technique in diagnosing any system
performance issues. The user can open the Link Test and Offline Diagnostic screens at the same time, run a short
Link Test with each Remote from the Master unit, then retrieve the Offline Diagnostics from the Master unit and
each Remote unit to determine if any parameters are not within acceptable limits.

4.4 Spectrum Analyzer

The Spectrum Analyzer utility is an effective tool for finding potential frequency trouble areas in the 902 to 928
MHz hopping band. Frequency areas found to be displaying at levels above the user’s noise floor threshold can be
analyzed more thoroughly to determine if they have a potential long term effect on system performance. Sub-bands
containing these frequencies can then be omitted from the Sub-Band Mask (refer to Section 3.3.1.3, ‘Radio Setup
Parameters’).

Refer to Section 3.5.5 for information on using the Spectrum Analyzer utility.
Important note: It is recommended that the Master radio be used to perform a spectrum sweep. If a sweep is

performed using a Remote unit while the Master is transmitting sync information, the Remote unit will likely detect
some of the Master’s sync transmissions.
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4.5 Sync Count Diagnostics

The Sync Count Diagnostics, described in Section 3.5.6, can be used to determine potential frequency trouble areas
over a period of time. Also, sync counts of multiple Remote units in the same system can be compared to determine
if there are any receive reliability issues.

After a Remote unit’s sync counter is cleared (all channel counters set to zero), each successful sync received on
each channel used by the system will increment the counter for that channel by one. The number of sub-bands the
user has enabled determines the time it takes to cycle through all active channels one time. Table 4.2 below lists the
approximate Sync Diagnostic timing cycles for a given number of sub-bands enabled.

Table 4.2 Sync Count Time Cycles

Approx. time to cycle Minimum time for a
Sub-Bands Selected Number of Channels one count on each
channel channel to reach 65535
2 64 19.2 sec 2.1 weeks
3 96 28.8 sec 3.1 weeks
4 128 38.4 sec 4.2 weeks
5 160 48.0 sec 5.2 weeks
6 192 57.6 sec 6.2 weeks
7 224 67.2 sec 7.3 weeks
8 256 1.3 min 2.1 months
9 288 1.4 min 2.3 months
10 320 1.6 min 2.6 months
11 352 1.8 min 2.9 months
12 384 1.9 min 3.1 months
13 416 2.1 min 3.4 months
14 448 2.2 min 3.6 months
15 480 2.4 min 3.9 months
16 512 2.6 min 4.2 months

The Sync Count Wrap Mode determines what happens to the stored sync count information when a channel reaches
a value of 65535 (see Section 3.3.1.1).

For example, if the Sync Count Mode is set to Zero Counts when 65535, a Remote unit with 8 sub-bands selected
will automatically zero out all channel counters in approximately 2.1 months.

If the same unit (8 sub-bands enabled) is set to Half Counts when 65535, then all channel counts will divide in half
after 2.1 months and start counting up again. The sync counts will then half again each month as the counter
reaches 65535. By halving the counts, information on past sync performance is not completely lost but, over time,
old sync count information will fade out.
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& SyncCnt.bd - Notepad !Elm

File Edit Search Help

D = 17 :J
Time = 13:2Z:51 03/21/2001
Channe1l SynocCount
1 1250
2 1251
3 1250
4 1250 s

Figure 4.4 Sync Count Text File

Figure 4.4 shows an example of a partial Sync Count Diagnostic output file. The default file name is SyncCnt.txt.
All 512 channel counts will be stored. Channels not in the currently active sub-band list will display ‘0’ counts.
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Section 5

Definitions

Bit dribble Extraneous bits delivered at the end of a data transmission. Equivalent to a “squelch tail”
in voice systems. The Integra-H does not have bit dribble.

COM Port The Communications Port of the Integra-H. This port is configured as DCE and is
designed to connect directly to DTE.

CTS Clear to Send. An RS-232 output signal from the Integra-H indicating that it is ready to
accept data (used in RTS mode).

DCE Data Communications Equipment. This designation is applied to equipment such as
modems. DCE is designed to connect to DTE.

DOX Data Operated Transmit. A mode of operation in which the Integra-H begins a
transmission as soon as data is presented to the RS-232 port.

DTE Data Terminal Equipment. This designation is applied to equipment such as terminals,
PCs, RTUs, PLCs, etc. DTE is designed to connect to DCE.

EIRP Effective Isotropic Radiated Power.

Full Channel Radio channel bandwidth equal to 25kHz.

Integra-H FPS The Integra-H Field Programming Software.

Network speed The bit rate on the RF link between units. Is different from the COM port baud rate.

PLC Programmable Logic Controller. An intelligent device that can make decisions, gather
and report information, and control other devices.

RTS Request to Send. RS-232 input signal to the Integra-H indicating that the DTE has data to
send. RTS may optionally be used to “wake up” the Integra-H from Sleep Mode.

RTS mode A mode of operation in which the Integra-H begins a transmission when RTS is raised and
continues transmitting until RTS is dropped.

RTU Remote Terminal Unit. A SCADA device used to gather information or control other
devices.
SCADA Supervisory Control And Data Acquisition. A general term referring to systems that

gather data and/or perform control operations.

SETUP Port The configuration / diagnostic port of the Integra-H. This port is designed to be connected
to a PC running the Integra-H FPS program.

Transparent A transparent unit transmits all data without regard to special characters, etc.
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DATARADIO

DATA TELEMETRY PRODUCT WARRANTY

Dataradio COR Ltd. ("DRL") warrants to the original purchaser for use
("Buyer"] that data telemetry products manufactured by DRL
("Products”) are free from defects in material and workmanship and
will conform to DRL's published technical specifications for a period of,
except as noted below, two (2] years from the date of shipment to
Buyer. DRL makes no warranty with respect to any equipment not
manufactured by DRL, and any such equipment shall carry the original
equipment manufacturer’'s warranty only. DRL further makes no
warranty as to and specifically disclaims liability for, availability, range,
coverage, grade of service or operation of the repeater system
provided by the carrier or repeater operator. Any return shipping
charges for third party equipment to their respective repair facilities
are chargeable and will be passed on to the Buyer.

If any Product fails to meet the warranty set forth above during the
applicable warranty period and is returned to a location designated by
DRL. DRL, at its option, shall either repair or replace such defective
Product, directly or through an authorized service agent, within thirty
(30] days of receipt of same. No Products may be returned without
prior authorization from DRL. Any repaired or replaced Products shall
be warranted for the remainder of the original warranty period. Buyer
shall pay all shipping charges, handling charges, fees and duties for
returning defective Products to DRL or DRL's authorized service agent.
DRL will pay the return shipping charges if the Product is repaired or
replaced under warranty, exclusive of fees and duties. Repair or
replacement of defective Products as set forth in this paragraph fulfills
any and all warranty obligations on the part of DRL.

This warranty is void and DRL shall not be obligated to replace or
repair any Products if (i) the Product has been used in other than its
normal and customary manner; (i) the Product has been subject to
misuse, accident, neglect or damage or has been used other than with
DRL approved accessories and equipment; (i) unauthorized alteration
or repairs have been made or unapproved parts have been used in or
with the Product; or (iv) Buyer failed to notify DRL or DRL's authorized
service agent of the defect during the applicable warranty period. DRL
is the final arbiter of such claims.

THE AFORESAID WARRANTIES ARE IN LIEU OF ALL OTHER
WARRANTIES, EXPRESSED AND IMPLIED, INCLUDING BUT NOT
LIMITED TO, ANY IMPLIED WARRANTY OF MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE. DRL AND BUYER AGREE
THAT BUYER'S EXCLUSIVE REMEDY FOR ANY BREACH OF ANY OF
SAID WARRANTIES IT AS SET FORTH ABOVE. BUYER AGREES THAT
IN'NO EVENT SHALL DRL BE LIABLE FOR INCIDENTAL,
CONSEQUENTIAL, SPECIAL, INDIRECT OR EXEMPLARY DAMAGES
WHETHER ON THE BASIS OF NEGLIGENCE, STRICT LIABILITY OR
OTHERWISE. The purpose of the exclusive remedies set forth above
shall be to provide Buyer with repair or replacement of non-complying
Products in the manner provided above. These exclusive remedies
shall not be deemed to have failed of their essential purpose so long
as DRL is willing and able to repair or replace non-complying Products
in the manner set forth above.

This warranty applies to all Products sold worldwide.

Some states do not allow limitations on implied warranties so the
above limitations may not be applicable. You may also have other
rights which vary from state to state.

EXCEPTIONS

ONE YEAR: Labor to replace defective parts in repeaters or
base stations

THIRTY DAY: Tuning and adjustment of telemetry radios

NO WARRANTY:  Fuses, lamps and other expendable parts

Effective 01/2004

Dataradio COR Ltd. 299 Johnson Avenue, Suite 110, Waseca, MN 56093-0833: Tel: (507) 833-8819 or (800) 992-7774; Fax: (507) 833-6748 Visit us on the web at www.dataradio.com
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